Using Oracle Discoverer™ with the Generic Data Base

Workshop Manual
Chapter 1:
Preface
Chapter 1: Preface

This manual describes the Oracle Discoverer™ product, a web-based query tool that you can use to retrieve data from Oracle-based databases such as the Generic Data Base (GDB). You then use Discoverer to format and generate reports with this retrieved data.

The Discoverer tool essentially enables you to execute queries in much the same way that command line-based SQL macros do. Discoverer’s features, however, eliminate the need for you to understand complex database concepts, macro-authoring, or the SQL language.

Discoverer has been updated to work with the May 2006 release of GDB 9.01.0. In this release, you can do the following tasks:

- Search for and retrieve data from any GDB tables.
- Edit your initial search queries and re-submit them to the GDB to get better or more comprehensive results.
- Use or customize Discoverer’s default report formats.
Help Resources for Oracle Discoverer™

There are a number of resources available to you as you start learning and using Oracle Discoverer™. In addition to this manual, help is available via:

<table>
<thead>
<tr>
<th>Name of Help Resource</th>
<th>Where to Find This Resource</th>
</tr>
</thead>
</table>
| VS-IT Helpdesk                       | http://vsithelpdesk.aphis.usda.gov/  
                                         vsithelp@cofcs18.aphis.usda.gov  
                                         877-944-8457                                                               |
| Online Help feature in the Discoverer product | In Discoverer's menu bar, select the Help menu item.                                      |
| Workbook Wizard in the Discoverer product | This interactive document automatically launches when you select the Create a new workbook option after logging into Discoverer. |
| Classroom-based training             | Watch for announcements at the USDA’s GDB website: http://gdb.aphis.usda.gov/               |
## Topics Covered in This Manual

<table>
<thead>
<tr>
<th>Chapter</th>
<th>Topic</th>
<th>See Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Preface</td>
<td>1.1</td>
</tr>
<tr>
<td></td>
<td>• Help Resources for Oracle Discoverer™</td>
<td>1.2</td>
</tr>
<tr>
<td></td>
<td>• Topics Covered in This Manual</td>
<td>1.3</td>
</tr>
<tr>
<td>2</td>
<td>About Oracle Discoverer for GDB 9.01.0</td>
<td>2.2</td>
</tr>
<tr>
<td></td>
<td>• Discoverer's Features</td>
<td>2.2</td>
</tr>
<tr>
<td></td>
<td>• Discoverer's Architecture</td>
<td>2.3</td>
</tr>
<tr>
<td></td>
<td>• Discoverer's User Interface</td>
<td>2.4</td>
</tr>
<tr>
<td></td>
<td>How Oracle Discoverer Works with the Generic Data Base</td>
<td>2.5</td>
</tr>
<tr>
<td></td>
<td>• Discoverer Terminology</td>
<td>2.5</td>
</tr>
<tr>
<td></td>
<td>• What is in a Database?</td>
<td>2.6</td>
</tr>
<tr>
<td></td>
<td>• What is in the GDB Tables?</td>
<td>2.7</td>
</tr>
<tr>
<td></td>
<td>• Using Functions and Table Joins in Discoverer</td>
<td>2.8</td>
</tr>
<tr>
<td></td>
<td>• GDB Species Groups</td>
<td>2.10</td>
</tr>
<tr>
<td>3</td>
<td>Installing Oracle Discoverer™</td>
<td>3.1</td>
</tr>
<tr>
<td></td>
<td>• Obtaining Your Login Information</td>
<td>3.2</td>
</tr>
<tr>
<td></td>
<td>• Setting Up Discoverer on Your System</td>
<td>3.3</td>
</tr>
<tr>
<td>4</td>
<td>Writing Queries with Discoverer</td>
<td>4.1</td>
</tr>
<tr>
<td></td>
<td>• Three Methods for Doing Queries with Discoverer</td>
<td>4.2</td>
</tr>
<tr>
<td></td>
<td>• Workflow for Doing a Query</td>
<td>4.3</td>
</tr>
<tr>
<td>5</td>
<td>Using a Pre-Defined Workbook in the GDB Workbook Library</td>
<td>5.1</td>
</tr>
<tr>
<td></td>
<td>• Using Pre-Defined Workbooks</td>
<td>5.2</td>
</tr>
<tr>
<td></td>
<td>• Detailed Descriptions of the Workbooks</td>
<td>5.5</td>
</tr>
<tr>
<td>6</td>
<td>Using Discoverer's Workbook Wizard</td>
<td>6.1</td>
</tr>
<tr>
<td></td>
<td>• Creating a New One-Table Query</td>
<td>6.2</td>
</tr>
<tr>
<td></td>
<td>• Creating a New Two-Table Query</td>
<td>6.18</td>
</tr>
<tr>
<td>7</td>
<td>Using Discoverer to Create a New Ad Hoc Query</td>
<td>7.1</td>
</tr>
<tr>
<td></td>
<td>• Creating a New Ad Hoc Worksheet Query Unassisted</td>
<td>7.2</td>
</tr>
<tr>
<td></td>
<td>• Printing Reports from a Worksheet Query</td>
<td>7.31</td>
</tr>
<tr>
<td>8</td>
<td>Managing Discoverer Workbooks</td>
<td>8.1</td>
</tr>
<tr>
<td></td>
<td>• Workbook-Related Tasks</td>
<td>8.2</td>
</tr>
<tr>
<td></td>
<td>• Worksheet-Related Tasks</td>
<td>8.8</td>
</tr>
<tr>
<td></td>
<td>• Using the Query Governor Feature</td>
<td>8.16</td>
</tr>
<tr>
<td>9</td>
<td>Using Calculations, Functions, and Table Joins in Oracle Discoverer</td>
<td>9.1</td>
</tr>
<tr>
<td></td>
<td>Plus</td>
<td>9.1</td>
</tr>
<tr>
<td></td>
<td>• Using Pre-Defined Table Joins</td>
<td>9.2</td>
</tr>
<tr>
<td></td>
<td>• Using Pre-Defined Calculations</td>
<td>9.2</td>
</tr>
<tr>
<td></td>
<td>• Incorporating Functions within Calculations</td>
<td>9.4</td>
</tr>
<tr>
<td>Appendix</td>
<td>Detailed Descriptions of Selectable Items in Oracle Discoverer Plus</td>
<td>A.1</td>
</tr>
</tbody>
</table>
Chapter 2: Introduction
Chapter 2: Introduction

This chapter describes how Oracle Discoverer™ works as a database query tool. You will also learn a few terms and concepts about databases in general.

The topics covered in this chapter appear below:

<table>
<thead>
<tr>
<th>Topic</th>
<th>See Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>About Oracle Discoverer</td>
<td></td>
</tr>
<tr>
<td>• Discoverer's Features</td>
<td>2.2</td>
</tr>
<tr>
<td>• Discoverer's Architecture</td>
<td>2.3</td>
</tr>
<tr>
<td>• Discoverer's User Interface</td>
<td>2.4</td>
</tr>
<tr>
<td>How Oracle Discoverer™ Works with the Generic Database</td>
<td></td>
</tr>
<tr>
<td>• Discoverer Terminology</td>
<td>2.5</td>
</tr>
<tr>
<td>• What is in a Database?</td>
<td>2.6</td>
</tr>
<tr>
<td>• What is in the GDB Tables?</td>
<td>2.7</td>
</tr>
<tr>
<td>• Using Functions and Table Joins in Discoverer</td>
<td>2.8</td>
</tr>
<tr>
<td>• GDB Species Groups</td>
<td>2.9</td>
</tr>
</tbody>
</table>
About Oracle Discoverer™

In this section, you will learn about the features, components, architecture, and end-user interface of Oracle Discoverer™.

Discoverer's Features

The Oracle Discoverer™ product is a web-based query tool, with a visual interface that enables you to browse Oracle-based databases, such as the Generic Data Base (hereafter referred to as "the GDB").

Discoverer's:

- Query features will help you create, run, and edit your ad hoc queries for searching and retrieving data from GDB tables. You can build your query either from scratch or by using a pre-defined query template.

- Visual interface includes pull-down menus, icon shortcuts, and a "Workbook Wizard" feature to help you graphically build your query statements by dragging and dropping individual components of the statement into a workbook window. After you finish building your query, Discoverer converts it into an SQL statement and executes it on the appropriate GDB tables.

- Report-design features help you format and view your query results using either pre-defined report templates or a customized report layout that you design yourself.

In a nutshell, Discoverer helps you execute database queries SQL-style without having to understand complex database concepts, macro-authoring, or the SQL language.
Discoverer's Architecture

While the phrase "query tool" may imply that Oracle Discoverer™ is just one piece of software, it actually is not. Oracle Discoverer™ actually consists of a number of components. Of all these components, there are four which are directly relevant to end users like you; these components make it possible for you to use Discoverer to query the data in the GDB's tables:

- **Discoverer Plus** – This component enables you to create and run queries and to output reports within a Web browser.

- **Discoverer Viewer** – This component enables you to view the workbooks (queries) that are either set up by your database administrator or created by you (which you do using Discoverer Plus).

- **Oracle 9iAS Application** – This component is the Oracle relational database application itself. It provides services and an HTTP server feature, and serves as the "middle-man" between your workstation and the virtual GDB tables.

- **Discoverer Metadata** – Also known as the "end-user layer", this component serves as a kind of translator, allowing you to use ordinary English terms instead of SQL and database languages to do your query and report-generation work. The Metadata then translates your plain-English instructions into SQL statements that are understandable by Oracle 9iAS.

- **GDB Tables** – These tables contain all of the data that you will be querying. Discoverer is "read-only" software, meaning that you cannot use the Discoverer product to add, remove, or alter any of the data in the GDB. You are using Discoverer to query, retrieve, and format this data only.
Discoverer's User Interface

As mentioned earlier, Discoverer provides a visual interface with a variety of features to help you do your data-query and report-generation work as efficiently as possible. Rather than having to memorize SQL statements and write SQL macros, you will be able to use Windows-like pull-down menus, pop-up lists of values, icon shortcuts, and more to do the same work.

In later chapters of this manual, you will see examples of all of the different visual interface features in Oracle Discoverer™. But, to introduce you to some of these visual features, shown below is one example of a Discoverer screen that you will be doing much of your work in.

Example – A Workbook Query Parameter Form
How Oracle Discoverer™ Works with the Generic Data Base

Even with Discoverer’s visual interface and Metadata "translator" services, there is no avoiding the fact that you are working with databases. This is a subject that can be confusing because it entails often complex models and concepts, along with its own unique terminology. So, to help you learn Discoverer more easily, this section discusses some fundamental database concepts and terms as they relate to Discoverer.

Discoverer Terminology

Even though you do not need to be familiar with database concepts in general, this manual does use several Discoverer-specific terms that you should know about:

- **Field**: The same as a column in a table. Contains a specific type of GDB data (e.g., a premises ID, a status code, or a disease name).
- **Query**: A search question that you formulate with Discoverer’s visual interface and then send to the GDB to be executed.
- **Record**: The same as a row in a table. Contains a set of related data (i.e., the record for a single premises would contain this set of related data: street address, city, state, and zip code information).
- **Report**: An electronic or hardcopy output which contains the results in a Discoverer worksheet. You can specify the appearance and layout of a report by using one of Discoverer’s pre-defined report templates, by modifying a template, or by creating a new report to meet your unique needs.
- **Worksheet**: A set of GDB data retrieved in response to a Discoverer query. This retrieved data is organized in a table-like format (typically a spreadsheet).
- **Workbook**: A collection of worksheets, all related in some way, but organized to show different perspectives.
  - **Example 1**: You create a workbook that contains data for a tuberculosis (TB) animal disease program in your state for the year 2003. Within this workbook, you have a separate worksheet for each animal species in your program:
    -- Worksheet 1 contains data for cattle in the 2003 TB program
    -- Worksheet 2 covers cervidae in the 2003 TB program
    -- Worksheet 3 covers goats in the 2003 TB program
  - **Example 2**: You create a workbook for your state's PRV animal disease program. Each worksheet in the workbook contains a different year's data.
  - **Example 3**: You create a workbook that contains the queries you do on a regular schedule:
    -- Worksheet 1 contains a PRV query for a monthly state report
    -- Worksheet 2 contains a BR query for a weekly report
    -- Worksheet 3 contains a BR query for the monthly national VS report
- **Workbook Wizard**: An interactive document that guides you through the steps of common Discoverer tasks, such as creating a query or customizing a report's layout.
What is in a Database?

A database is simply a collection of pieces of information (data). All of these data are related in some way.

How a database organizes its data depends on the structure set up for that database. There are many different structures that can be used to organize a database. Oracle 9iAS and the GDB use the relational structure; hence, they are known as relational databases.

A relational database has the following features:

- Stores its data within tables, which are made up of columns and rows. (As explained in the previous section, a table column is the same as a field or type of information. And a row is the same as a single record.)

A table contains data that shares a common purpose, subject, or theme. In the GDB, for example, the Premises Table contains different kinds of data, all of which define the physical attributes of a premises in some way. Some of the columns (fields) in this table are listed below:

  - prem_ID (a unique identification number for a specific premises)
  - prem_address (the street address for a specific premises)
  - front_gate_latitude (the geological coordinate for the entrance to a specific premises from a public-access road)

- Uses rules to govern relationships between the tables in the database. Some of these rules dictate how individual tables can link or combine their data together. These rules are implemented in various formats, such as joins, calculations, and functions. (See Chapter 9 for more information about this topic.)

- Requires a programming language (such as SQL) to access the information in the database. (Remember, Discoverer is able to translate your plain-English query requests into SQL so that you can retrieve data from the GDB.)

To avoid having to write an SQL macro or query to accomplish this data-retrieval from several tables, you will be using Discoverer instead.
What is in the GDB Tables?

As mentioned earlier, this initial Discoverer release allows you to run Discoverer queries on all of the GDB tables. The table below introduces you to several of these tables and their contents:

<table>
<thead>
<tr>
<th>Table Name and Purpose</th>
<th>Table Prefix</th>
<th>Partial List of Fields in This Table</th>
</tr>
</thead>
<tbody>
<tr>
<td>Event_Summary</td>
<td>ES</td>
<td>Event Date = event date&lt;br&gt;Species = the animal species tested&lt;br&gt;Event Type = the type of event</td>
</tr>
<tr>
<td>Premises</td>
<td>PR</td>
<td>Prem Id = a premises identification number&lt;br&gt;Prem Address = a premises address&lt;br&gt;Prem City = a premises' city&lt;br&gt;Contact Lname = a contact person's last name</td>
</tr>
<tr>
<td>Premises_Supplemental</td>
<td>PS</td>
<td>Prem Species = the species residing on a premises&lt;br&gt;Prem Type = the type of operation conducted at that premises (i.e., a dairy or feedlot)</td>
</tr>
<tr>
<td>Sample</td>
<td>SA</td>
<td>Id1 = an eartag identification number for an individual animal&lt;br&gt;Age = the age of an animal&lt;br&gt;Nr Sus = the number of animals in a group that received a “suspect” test result</td>
</tr>
<tr>
<td>Status</td>
<td>ST</td>
<td>Status Code = the current status level of a herd&lt;br&gt;Issue Date = the date on which a herd was assigned its status&lt;br&gt;Release Date = the date on which a herd was no longer in the related status&lt;br&gt;Issue Rsn = the reason for issuing a status to a herd</td>
</tr>
<tr>
<td>Test_Result</td>
<td>TR</td>
<td>Test Name = the name of a specific test&lt;br&gt;Disease = the results for a specific test</td>
</tr>
</tbody>
</table>
As you can see from the preceding chart, each table contains fields and information that are unique to that table. So, you could create a query that generates a report containing data on the age, breed, and sex for animal herds in one state. This query is known as a one-table query, because all of its data comes from the Sample Table alone. Your report would not contain any data typically stored in other tables, such as Events_Summary or Status.

But suppose you want to generate a report that includes data from several different tables? For example, you might want a report that summarizes not only the age, breed, and sex of animal herds in one state (available only in the Sample Table), but also the test results for all of those animals (found in the Test_Results Table).

In relational databases, a common method for running a multi-table query is to use a technique called a table join. A table join enables you to merge the data of two or more tables into one table. This helps you avoid having to write an SQL macro or query to accomplish this data-retrieval from several tables.

**Using Functions and Table Joins in Discoverer**

This new version of Discoverer even goes one step further. Instead of having to select and specify table joins manually, Discoverer provides you with a variety of calculations that replace the most commonly-used table joins. There are also seven comprehensive table joins, if you still prefer to use them.

For this release of Discoverer, you can run multi-table queries using any of the following methods:

- Pre-defined table joins that appear in the Discoverer Workbook Wizard – Step 2 of 10: Select Items Screen. These pre-defined table joins have ALL as their suffix.
- Calculations that appear in the Workbook Wizard – Step 7 of 10: Calculations Screen.
- Functions that can be incorporated within calculations.

For a detailed explanation on calculation syntax and examples, refer to Chapter 9 in this manual.
GDB Species Groups

Most VS animal disease control programs gather data for more than one species that is participating or enrolled in that program. Often, these sub-species are categorized into a species group. The table below lists the GDB species groups and their sub-species:

<table>
<thead>
<tr>
<th>Name of Species Group</th>
<th>Sub- Species In This Group</th>
</tr>
</thead>
<tbody>
<tr>
<td>BOV</td>
<td>BOV = Bovine</td>
</tr>
<tr>
<td></td>
<td>BIS = Bison</td>
</tr>
<tr>
<td>CAM</td>
<td>CAM = Camelid</td>
</tr>
<tr>
<td>CAP</td>
<td>CAP = Caprine</td>
</tr>
<tr>
<td>CER</td>
<td>CER = Cervidae</td>
</tr>
<tr>
<td>DER</td>
<td>DER = Deer</td>
</tr>
<tr>
<td>ELK</td>
<td>ELK = Elk</td>
</tr>
<tr>
<td>FAL</td>
<td>FAL = Fallow Deer</td>
</tr>
<tr>
<td>MDR</td>
<td>MDR = Mule Deer</td>
</tr>
<tr>
<td>MSE</td>
<td>MSE = Moose</td>
</tr>
<tr>
<td>RD</td>
<td>RD = Red Deer</td>
</tr>
<tr>
<td>RND</td>
<td>RND = Reindeer</td>
</tr>
<tr>
<td>WTD</td>
<td>WTD = White-Tail Deer</td>
</tr>
<tr>
<td>EQU</td>
<td>EQU = Equine</td>
</tr>
<tr>
<td>FER</td>
<td>CSW = Captive Swine</td>
</tr>
<tr>
<td></td>
<td>FER = Feral Swine</td>
</tr>
<tr>
<td>NWC</td>
<td>ALP = Alpaca</td>
</tr>
<tr>
<td></td>
<td>GUA = Guanaco</td>
</tr>
<tr>
<td></td>
<td>LLA = Llama</td>
</tr>
<tr>
<td></td>
<td>NWC = New World Camelid</td>
</tr>
<tr>
<td></td>
<td>VIC = Vicuna</td>
</tr>
<tr>
<td>OTH</td>
<td>OTH = Other Species</td>
</tr>
<tr>
<td>OVI</td>
<td>OVI = Ovine</td>
</tr>
<tr>
<td>POR</td>
<td>POR = Porcine</td>
</tr>
</tbody>
</table>

Note: The species that appear in the **Name of Species Group** column above are also considered to be stand-alone species by themselves. This is important to keep in mind, as it will affect the data results you get in your Discoverer queries. (More about this below.)

When you run a pre-made Discoverer query, in most cases you will be able to specify whether you want data for all of the sub-species within a species group, or data for just one particular sub-species.
Chapter 3:
Installing Oracle Discoverer™
Chapter 3: Installing Oracle Discoverer™

This chapter contains the procedures to follow for obtaining your Oracle Discoverer™ login information and then initially configuring the Discoverer product for your system.

In this document, you will learn about the following:

<table>
<thead>
<tr>
<th>Topic</th>
<th>See Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Obtaining Your Login Information</td>
<td>3.2</td>
</tr>
<tr>
<td>Setting Up Discoverer on Your System</td>
<td>3.3</td>
</tr>
<tr>
<td>• Manually Installing Oracle JInitiator</td>
<td>3.4</td>
</tr>
<tr>
<td>• Configuring Your Discoverer Plus Connection</td>
<td>3.5</td>
</tr>
<tr>
<td>• Setting Up the Security Worksheet</td>
<td>3.9</td>
</tr>
<tr>
<td>• Report Template</td>
<td>3.13</td>
</tr>
</tbody>
</table>
Obtaining Your Login Information

To access and enter the Oracle Discoverer™ web site, you will need a user account set up for you. Specifically, you will need a user name, a password, and a database designation.

When you request a user account for the GDB, you can also request a Discoverer account to be set up for you. Both requests can be made by contacting the VS-IT Helpdesk as described on page 1.2. Be aware that you will need to specify the system(s) that you will be using Discoverer with, as each system may have a different login ID associated with it.

Currently, Discoverer is set up to work with the GDB, AHSM-Scrapie, and the CAPP.
Setting Up Oracle Discoverer™ on Your System

Before you can use Discoverer, a plug-in utility called Oracle JInitiator™ must be installed on your system. This plug-in enables Oracle Discoverer™ to work within your web browser.

Note: If your computer runs:
  -- under Windows 2000/XP/2003, then Oracle JInitiator™ must be installed by someone who has administrator-level privileges.
  -- under Windows 95/98, then Oracle JInitiator™ can be installed by someone who has local privileges.

Oracle JInitiator will automatically install the first time you connect to Discoverer on a particular computer. Accept the default installation location, and select “Next” until the installation is complete.
Configuring Your Discoverer Plus Connection

2.1 At your computer desktop screen, launch your web browser.

2.2 In the browser's Location field, enter the Discoverer web site’s URL:

http://mdwebforms.aphis.usda.gov/discoverer/plus?
http://cowebforms.aphis.usda.gov/discoverer/plus?

Note that you will use mdwebforms if your GDB is on mdvsreg, and you will use cowebforms if your GDB is on covsreg or covsnat.

A Connect to Discoverer Plus Screen (shown below) will appear.

2.3 On this screen, just above the table, click on Create Connection.

A Create Connection screen now appears.
2.4 Fill out the **Create Connection** form, using these guidelines:

<table>
<thead>
<tr>
<th>Field</th>
<th>Data to Enter</th>
</tr>
</thead>
<tbody>
<tr>
<td>Connection Name</td>
<td>Easy-to-remember name of the Oracle instance you will most frequently connect to for your work sessions.</td>
</tr>
<tr>
<td>Connection Description</td>
<td>Full description of the Oracle instance you will most frequently connect to for your work sessions.</td>
</tr>
<tr>
<td>Locale</td>
<td>Accept the default.</td>
</tr>
<tr>
<td>User Name</td>
<td>Name assigned as part of your user profile.</td>
</tr>
<tr>
<td>Password</td>
<td>Password assigned as part of your user profile.</td>
</tr>
</tbody>
</table>
| Database                 | - Eastern Region personnel should use mdvsreg.aphis.usda.gov  
                           - Western Region personnel should use covsreg.aphis.usda.gov  
                           - All personnel accessing scrapie data on covsnat should use covsnat.aphis.usda.gov  
                           - Texas personnel and states using NT servers can not use Oracle Discoverer on their local GDB. |

When done, your screen should look similar to this example:

![Oracle Application Server](image)

2.5 Click on **Apply**.

You return to the **Connect to Discoverer Plus** Screen. In the table, you should now see a record for the connection you just created.
2.6 Click on the hyperlink for the connection you just created. 
A **You are connecting...** login screen (see below) will appear.

![Login screen](image)

2.7 Enter your password, then click on **Connect**.

After a few seconds, Oracle Discoverer Plus will start up and display the following two screens:

![Workbook Wizard](image)
• The smaller screen in front shows the first page of the **Workbook Wizard**, a set of ten interactive screens that prompts and guides you through the process of creating a new workbook.

• The screen underneath is the **Discoverer Plus Main Window**, with a Menu Bar and Toolbar. You will use this screen to edit existing workbooks or when you no longer want to use the Workbook Wizard.

2.8 Close the **Workbook Wizard** screen by clicking on **Cancel**.

2.9 Continue on to the next section, **Setting Up the Security Worksheet**.
Setting Up the Security Worksheet

The Security Worksheet is a new feature in this release of Oracle Discoverer Plus. Its purpose is to set up an area in memory to hold the state that you are accessing. You will only have access to GDB data for that state that was granted to you in your user profile.

You need to execute the Security Worksheet only once at the beginning of each work session. If you do not do this, any reports you run during the work session will not return any data. There are two ways to execute it:

<table>
<thead>
<tr>
<th>Method</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Method A</td>
<td>Run the Security Worksheet as a standalone report.</td>
</tr>
<tr>
<td>Method B</td>
<td>Access and set up the Security Worksheet while working within another report.</td>
</tr>
</tbody>
</table>

Each method is described below.

Method A – Executing the Security Worksheet as a Standalone Report

A.1 Enter the Oracle Discoverer Plus web site and select the connection you want to use.

A.2 In the **Discoverer Plus Main Window**, select **File > Open**.

An Open Workbook from Database pop-up window appears.

A.3 Select **Open an Existing Workbook**, then select the **Database** option. A list of available workbooks now appears in the Open Workbook from Database pop-up window.

A.4 Highlight the **GDB_ACCESS_SETUP.DIS** workbook. Click on **Open**.

An Edit Parameter Values form (see right) will appear.
A.5 In this form, enter a two-letter code for the State whose GDB data you want to retrieve in your queries and reports. You can specify only one State. Note that if you are connecting to COVSNAT for scrapie data, you will enter “US” as your state. Then click on OK.

A.6 The Security Worksheet will be executed, and the report shown at right will be returned:

- If State access is granted, you will see the above report, with the State’s code in the States_Allowed field. If you are connecting to COVSNAT for Scrapie, you will see “US” in the States_Allowed field.
- If State access is not granted, you will see two tilde (~~) symbols instead of the State’s code in the States_Allowed field.

A.7 You may now create new workbooks, or open and run existing workbooks.
Method B – Executing the Security Worksheet while in Another Report

B.1 You should already have an existing workbook open within the Discoverer Plus Main Window (see below).

B.2 At the bottom of the window, find and click once on the Set Access State tab.

An Edit Parameter Values form will appear (see below).
B.3 In this form, enter a two-letter code for the State whose GDB data you want to retrieve in your queries and reports. You can specify only one State. If you are connecting to COVSNAT for Scrapie, you should enter “US” as the user state.

Then click on OK.

The Security Worksheet will be executed, and the report shown below will be returned.

- If State access is granted, you will see the above report, with the State’s code in the States_Allowed field. If you are connecting to COVSNAT for Scrapie, you will see “US” in the States_Allowed field.

- If State access is not granted, you will see two tilde (~~) symbols instead of the State’s code in the States_Allowed field.

B.4 You can now click on the Report tab to return to the worksheet you were working in.
Chapter 4:
Writing Queries with Discoverer
Oracle Discoverer™ is a very flexible ad hoc query tool that can be used in a variety of ways to accomplish your queries and report-generation tasks. This chapter will describe the three primary methods you can execute to run Discoverer queries on GDB data. But, regardless of which method you use, the general workflow (sequence of tasks) will be the same.

The topics covered in this chapter appear below:

<table>
<thead>
<tr>
<th>Topic</th>
<th>See Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Three Methods for Doing Queries with Discoverer</td>
<td>4.2</td>
</tr>
<tr>
<td>• Using a pre-defined workbook from the GDB Workbook Library</td>
<td>4.2</td>
</tr>
<tr>
<td>• Interactively with the Workbook Wizard</td>
<td>4.2</td>
</tr>
<tr>
<td>• Creating a new workbook unassisted</td>
<td>4.2</td>
</tr>
<tr>
<td>Workflow for Doing a Query</td>
<td>4.3</td>
</tr>
</tbody>
</table>
Three Methods for Constructing a Discoverer Query

Discoverer provides a variety of methods for constructing (building) a query, in order to assist all users, whether they are new or experienced users of Oracle databases or of Oracle Discoverer™. These three methods are described below:

<table>
<thead>
<tr>
<th>Method</th>
<th>Description of Method</th>
</tr>
</thead>
</table>
| Open and use a pre-defined workbook available in the GDB Workbook Library. | This method enables you to pick an existing workbook that already contains the query you want to run. You can either:
  - run this query "as is"  
  - save this query under a new name, modify its parameters, conditions, calculations, etc., and then run it  
  This method is described in Chapter 5. |
| Create a new workbook by using Discoverer’s Workbook Wizard           | This method lets you create a new workbook step-by-step as you proceed through the Workbook Wizard. This method is described in Chapter 6 |
| Create a new workbook within the Discoverer **Edit Worksheet Screen**  | This method lets you construct a new workbook from within a single master window, with tabbed pages to various dialog boxes where you can customize various aspects of your query. This method is described in Chapter 7. |

Once you start building up a collection of workbooks, you then need to learn how to manage them. Procedures for refining, renaming, deleting, duplicating, and printing workbook properties are found in Chapter 8.
## Workflow for Constructing a Query

A Discoverer query can be simple or complex, depending on the data you are querying, the results you expect to retrieve, and the report design you want to output. But every Discoverer query can be constructed by completing the same set of tasks. And you will execute this same task set, regardless of which method (described in the previous section) you use.

At minimum, there are two tasks that you should complete for each Discoverer query you write. For more complex queries, you may need to complete up to ten tasks total.

<table>
<thead>
<tr>
<th>Simple Query</th>
<th><strong>Mandatory Tasks You Must Do:</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>2. Select the data items from the appropriate tables to store in your workbook and to use in your query.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Complex Query</th>
<th><strong>Mandatory Tasks You Must Do:</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>2. Select the data items from the appropriate tables to store in your workbook and to use in your query.</td>
</tr>
<tr>
<td></td>
<td><strong>Optional Tasks You Can Do:</strong></td>
</tr>
<tr>
<td></td>
<td>3. Specify the appearance and layout of the data itself within the report template.</td>
</tr>
<tr>
<td></td>
<td>4. Define any necessary conditions for which rows will be returned by your query.</td>
</tr>
<tr>
<td></td>
<td>5. Define any necessary sort criteria.</td>
</tr>
<tr>
<td></td>
<td>6. Define any necessary calculations that are appropriate in your query.</td>
</tr>
<tr>
<td></td>
<td>7. Specify any formulas you want Discoverer to use in calculating totals.</td>
</tr>
<tr>
<td></td>
<td>8. Define any necessary percentage values for your query.</td>
</tr>
<tr>
<td></td>
<td>9. Define any parameters, which allow the user to dynamically change the conditions for which rows are returned by the query.</td>
</tr>
<tr>
<td></td>
<td>10. Specify how you want Discoverer to format and display the data, the report headings, and any numerical values in the Results Screen and/or in the output report.</td>
</tr>
</tbody>
</table>
Chapter 5:
Using a Pre-Defined Workbook in the GDB Workbook Library
Chapter 5: Using a Pre-Defined Workbook in the GDB Workbook Library

This chapter describes a set of pre-defined workbook queries that are included with Discoverer. These pre-defined workbooks enable you to perform commonly-needed queries without having to write them yourself.

The topics covered in this chapter appear below:

<table>
<thead>
<tr>
<th>Topic</th>
<th>See Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Using Pre-Defined Workbooks</td>
<td>5.2</td>
</tr>
<tr>
<td>Detailed Descriptions of the Workbooks</td>
<td>5.5</td>
</tr>
</tbody>
</table>
Using Pre-Defined Workbooks

Using a pre-defined workbook query is a quick, efficient, and easy way to run a Discoverer query for GDB data. You do not have to write a pre-defined query from scratch, or test it, or analyze its initial reports to verify that it is retrieving the data results you expect.

There are, however, a few caveats you should keep in mind when using pre-defined workbooks:

- You cannot save over an original, pre-defined workbook. Instead, open the original workbook and then immediately save it under a new name. You can then modify the second version of the workbook as little or as much as you wish. (See Chapter 8, Renaming a Workbook, for more details.) If you do modify an original report, you will be required to give it a new name before saving it, thus protecting the original from being overwritten.

- Do not save any modified workbooks to your office/state/federal Discoverer account. These accounts are usually accessible by a large number of people. If everyone started adding additional workbooks, these accounts would quickly become very cluttered with redundant workbooks.

  Instead, make it a habit to always save any workbooks you modify or create from scratch into your own personal Discoverer account. Then check with your database administrator about the merits of adding your workbook to the office/state/federal account.

- If you have created a new workbook that you feel would benefit the APHIS community as a whole, please contact the VS-IT Helpdesk to discuss this possibility. (Contact information for the VS-IT Helpdesk appears in Chapter 1.)
Opening a Pre-Defined Workbook

1. Log into the Oracle Discoverer™ website by following the instructions on page 3.4.

2. When the Workbook Wizard, Step 1 of 10 screen appears, click on the option, Open an existing workbook (shown at right).

3. A second prompt will appear on this same screen. Click on the option, Database (as shown).

4. The Open Workbook From Database popup window shown at right will appear.

   Find and highlight the workbook you wish to use. Then click on [Open].

   The parameter form for the workbook you selected will appear. This form is ready for you to enter your search values.
5. You can now do any of several things:

- If you want to simply run this workbook query, enter your search values in the fields on the form. Then click on [OK].
  Discoverer will execute the query and display any results onscreen.

- If you want to modify the query itself so that it will use different parameters or retrieve different results, do the following:
  i. Click on [Cancel]. The parameter form will close and you will see a blank worksheet in the workbook.
  ii. In the Discoverer menu bar, select the File → Save As menu item.
  iii. A Save Workbook To Database popup window will appear. This window lists all of the workbooks currently in the GDB. In the New Name field below the list, type the name that you want to give to your modified workbook. Then click on [Save].

  The workbook will be saved under the name you just created. You can see this new name in the workbook's title bar (above the Discoverer menu bar).

  You can now modify this workbook as little or as much as you like.
Detailed Descriptions of the Workbooks

In this section you will find detailed descriptions for most of the Discoverer workbooks.

These descriptions appear in alphabetical order, according to the names of the workbooks.

Each workbook's description contains the following items (if applicable):

- The workbook's objective (the results this workbook query should retrieve)
- The GDB tables that this workbook query will extract its data from
- Any conditions (table joins, matching values across tables, etc.) that must be met in order to run this workbook query successfully
- A screen shot of the parameter form you need to complete in order to run the query
- A screen shot of the results you might see from a successful query
GDB_CEAH_BRT_PATRON.DIS

<table>
<thead>
<tr>
<th>Workbook's Objective:</th>
<th>This worksheet returns patron information based on a particular round.</th>
</tr>
</thead>
</table>
| Workbook Retrieves Data From: | • Event_Summary Table  
• Sample Table  
- whose id2 = null or id2_source = null  
- whose id2 = null or id2_source = null |
| To Successfully Run This Worksheet Query: | • Event_Summary Table's es_nr = Sample Table's es_nr  
• Event_Summary Table's entry_state = Sample Table's entry_state |

To generate a report with this worksheet, you will fill out the following parameter form. In the field, enter your value using the following format: YYYYRRR (where YYYY is the four-digit number of the year and RRR is the three-digit number for the round number itself).
### GDB_CEAH_BRT_ROUNDS.DIS

<table>
<thead>
<tr>
<th>Workbook's Objective:</th>
<th>This worksheet returns round information based on a state parameter.</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Workbook Retrieves Data From:</strong></td>
<td><strong>Workbook Retrieves Data Based on These Outer Joins:</strong></td>
</tr>
<tr>
<td>• Event_Summary Table</td>
<td>• Outer Join 1… the Event_Summary es_nr value joins the Sample es_nr value</td>
</tr>
<tr>
<td>• Sample Table</td>
<td>• Outer Join 2… the Event_Summary entry_state value joins the Sample entry_state value **</td>
</tr>
<tr>
<td>event_type = BRT and event_rsn = BRT and species = BOV ** An outer join returns records from one table that does not have a direct match in the other table.</td>
<td></td>
</tr>
</tbody>
</table>

To generate a report with this worksheet, you will fill out the following parameter form.

Another screen may appear. If it does, be sure to specify the **ES&SAI OUTER join; if you do not, the report generated will be incorrect.**
**GDB_CEAH_Data_Entry_Report.DIS**

**Workbook's Objective:**
This worksheet lists event_summary information based on the event_entry_date for Brucellosis.

**Workbook Retrieves Data From:**
- Premises Table
- Event_Summary Table
  - prem_name, prem_city
  - prem_id, event_date, event2_date, event_entry_date, person_id, nr_neg, nr_pos, nr_oth, event_rsn

**To Successfully Run This Worksheet Query:**
Premises Table's prem_ID = Event_Summary Table's prem_ID

To generate a report with this worksheet, you will fill out the following parameter form:

![Edit Parameter Values](Image)

Below is an excerpt of a printed report generated by this worksheet's query:

<table>
<thead>
<tr>
<th>Prem Name</th>
<th>Prem City</th>
<th>Prem ID</th>
<th>Event Date Lb</th>
<th>&gt; Event Date</th>
<th>Event2 Date Lb</th>
<th>&gt; Event2 Date</th>
<th>Event Entry Date Lb</th>
<th>&gt; Event Entry Date</th>
<th>Person</th>
</tr>
</thead>
<tbody>
<tr>
<td>1 Garfield Eric</td>
<td>Sension</td>
<td>TX01</td>
<td>21-MAY-2003</td>
<td>Lab Date</td>
<td>21-MAY-2003</td>
<td>Event Entry Date</td>
<td>22-MAY-2003</td>
<td>Person</td>
<td></td>
</tr>
<tr>
<td>2 Trophy Mountain</td>
<td>Cowdrey</td>
<td>CO005</td>
<td>Date Collected</td>
<td>Date Submitted</td>
<td>Event Entry Date</td>
<td>07-JAN-2003</td>
<td>Submit</td>
<td></td>
<td></td>
</tr>
<tr>
<td>3 Trophy Mountain</td>
<td>Cowdrey</td>
<td>CO005</td>
<td>07-JAN-2003</td>
<td>Last Inv Date</td>
<td>Event Entry Date</td>
<td>07-JAN-2003</td>
<td>Person</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
GDB_CEAH_Eartag_Search.DIS

Workbook's Objective: This worksheet queries ALL eartag information for Brucellosis.

Workbook Retrieves Data From:
- Premises Table
- Event_Summary Table
- Sample Table
- Test_Result Table
- all eartag-related information
- all eartag-related information
- all eartag-related information
- all eartag-related information

Workbook Retrieves Data Based on These Outer Joins:
- Outer Join 1… the Sample es_nr value joins the Test_Result es_nr value
- Outer Join 2… the Sample seq_nr value joins to the Test_Result seq_nr value
- Outer Join 3… the Sample disease value joins to the Test_Result disease value

To Successfully Run This Worksheet Query:
- Premises Table's prem_ID = Sample Table's prem_ID
- Event_Summary Table's es_nr = Sample Table's es_nr

** An outer join returns records from one table that does not have a direct match in the other table.

To generate a report with this worksheet, you will fill out the following parameter form. You may enter up to five eartag numbers. Each field on the form must be filled in; if you do not need to use a field, you must enter the word **None** instead.

Below is an excerpt of a printed report generated by this worksheet's query:

<table>
<thead>
<tr>
<th>SubsettingPremID</th>
<th>SubsettingID</th>
<th>Es Nr Lb</th>
<th>Es Nr</th>
<th>SubsettingPremName</th>
<th>SubsettingTestOrder</th>
<th>ES Event Date Lb</th>
<th>Yr ES Event Date</th>
<th>SubsettingEnv</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>C0952244</td>
<td>75RR313</td>
<td>20030592102</td>
<td>PR PremName</td>
<td>N</td>
<td>22-APR-2002</td>
<td>UPDHO</td>
<td></td>
</tr>
<tr>
<td>2</td>
<td>C0952244</td>
<td>75RR313</td>
<td>20030592102</td>
<td>PR PremName</td>
<td>N</td>
<td>22-APR-2002</td>
<td>UPDHO</td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>C0952244</td>
<td>75RR313</td>
<td>20030592102</td>
<td>PR PremName</td>
<td>N</td>
<td>22-APR-2002</td>
<td>UPDHO</td>
<td></td>
</tr>
<tr>
<td>4</td>
<td>C0952244</td>
<td>75RR313</td>
<td>20030592102</td>
<td>PR PremName</td>
<td>N</td>
<td>22-APR-2002</td>
<td>UPDHO</td>
<td></td>
</tr>
<tr>
<td>5</td>
<td>C0952244</td>
<td>75RR313</td>
<td>20030592102</td>
<td>PR PremName</td>
<td>N</td>
<td>22-APR-2002</td>
<td>UPDHO</td>
<td></td>
</tr>
<tr>
<td>6</td>
<td>NO6902</td>
<td>75RR313</td>
<td>200316990810</td>
<td>PR PremName</td>
<td>N</td>
<td>Call Date</td>
<td>TEST</td>
<td></td>
</tr>
</tbody>
</table>

5.9
**GDB_CEAH_Herd_Status.DIS**

**Workbook's Objective:** This worksheet displays open status records.

**Workbook Retrieves Data From:**
- Premises Table
- Status Table
  - prem_id, prem_name, prem_address, county
  - iss_date

**To Successfully Run This Worksheet Query:**
- Premises Table's prem_ID = Status Table's prem_ID
- Premises Table's prem_state = Status Table's prem_state
- Rel_date = null

To generate a report with this worksheet, you will fill out the following parameter form.

Below is an excerpt of a printed report generated by this worksheet's query:

<table>
<thead>
<tr>
<th></th>
<th>Prem County</th>
<th>Prem ID</th>
<th>Prem Name</th>
<th>Prem Address</th>
<th>Issue Date Lb</th>
<th>Issue Date</th>
<th>Disease</th>
<th>Species</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Prem County</td>
<td>Prem ID</td>
<td>Prem Name</td>
<td>Prem Address</td>
<td>10-DEC-1986</td>
<td></td>
<td>BR</td>
<td>BOV</td>
</tr>
<tr>
<td>2</td>
<td>Prem County</td>
<td>Prem ID</td>
<td>Prem Name</td>
<td>Prem Address</td>
<td>25-SEP-1987</td>
<td></td>
<td>BR</td>
<td>BOV</td>
</tr>
<tr>
<td>3</td>
<td>Prem County</td>
<td>Prem ID</td>
<td>Prem Name</td>
<td>Prem Address</td>
<td>07-NOV-1987</td>
<td></td>
<td>BR</td>
<td>BOV</td>
</tr>
</tbody>
</table>
GDB_CEAH_Herd_Status_List.DIS

Workbook's Objective: This worksheet shows detailed information for open status records.

Workbook Retrieves Data From:
- Premises Table
  - prem_id, prem_name, prem_address, county
  - iss_date
- Status Table

To Successfully Run This Worksheet Query:
- Premises Table's prem_ID = Status Table's prem_ID
- Premises Table's prem_state = Status Table's prem_state
- Rel_date = null

To generate a report with this worksheet, you will fill out the following parameter form.

Below is an excerpt of a printed report generated by this worksheet's query:

<table>
<thead>
<tr>
<th>Prem ID</th>
<th>From Name</th>
<th>From County</th>
<th>Issue Date</th>
<th>r Issue Date</th>
<th>r Release Date</th>
<th>Disease</th>
<th>Species</th>
</tr>
</thead>
<tbody>
<tr>
<td>C0</td>
<td>Livestock</td>
<td>002</td>
<td>09-MAY-1998</td>
<td>29-MAY-1998</td>
<td>NULL</td>
<td>ER</td>
<td>BOV</td>
</tr>
<tr>
<td>C0</td>
<td>Livestock</td>
<td>003</td>
<td>01-APR-1999</td>
<td>03-APR-2000</td>
<td></td>
<td>ER</td>
<td>BOV</td>
</tr>
<tr>
<td>C0</td>
<td>Livestock</td>
<td>003</td>
<td>16-MAY-2000</td>
<td>02-APR-2000</td>
<td></td>
<td>ER</td>
<td>BOV</td>
</tr>
<tr>
<td>01</td>
<td>Livestock</td>
<td>015</td>
<td>09-MAY-1998</td>
<td>29-MAY-1998</td>
<td>NULL</td>
<td>ER</td>
<td>BOV</td>
</tr>
</tbody>
</table>
GDB_CEAH_Herd_Summary.DIS

<table>
<thead>
<tr>
<th>Workbook's Objective:</th>
<th>This worksheet will calculate two totals: one for the number of animals tested for a specific prem_ID and one for the total of animals tested for the report.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Workbook Retrieves Data From:</td>
<td>Any table whose: event_type = TBCF, TBCC, TBCV, TBOT</td>
</tr>
</tbody>
</table>
| To Successfully Run This Worksheet Query: | • Premises Table's prem_ID = Event_Summary Table's prem_ID  
• Premises Table's prem_state = Event_Summary Table's prem_state |

To generate a report with this worksheet, you will fill out the following parameter form:

Below is an excerpt of a printed report generated by this worksheet's query:

<table>
<thead>
<tr>
<th>Prem_ID</th>
<th>Event_Date</th>
<th>Event_Date</th>
<th>NR Neg</th>
<th>NR Sus</th>
<th>NR Pos</th>
<th>NR Oth</th>
<th>Prem_Name</th>
<th>Prem_City</th>
<th>NR TESTED</th>
<th>ES NR</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>22-JUN-1993</td>
<td>22-JUN-1993</td>
<td>1</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>Prem Name</td>
<td>Prem City</td>
<td>1</td>
<td>BR Es</td>
</tr>
<tr>
<td>2</td>
<td>22-JUN-1993</td>
<td>22-JUN-1993</td>
<td>1</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>Prem Name</td>
<td>Prem City</td>
<td>1</td>
<td>Es Nr</td>
</tr>
<tr>
<td>3</td>
<td>03-SEP-1993</td>
<td>03-SEP-1993</td>
<td>1</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>Prem Name</td>
<td>Prem City</td>
<td>1</td>
<td>BR Es</td>
</tr>
<tr>
<td>4</td>
<td>03-SEP-1993</td>
<td>03-SEP-1993</td>
<td>1</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>Prem Name</td>
<td>Prem City</td>
<td>1</td>
<td>Es Nr</td>
</tr>
</tbody>
</table>
GDB_CEAH_Herd_Summary_List.DIS

<table>
<thead>
<tr>
<th>Workbook's Objective:</th>
<th>This worksheet queries for Brucellosis disease information.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Workbook Retrieves Data From:</td>
<td>Any table whose: - event_type = TEST and - prem_type ≠ FSL, SSL, CSL, RSP, FPC, MKT</td>
</tr>
<tr>
<td>Workbook Retrieves Data Based on This Outer Join:</td>
<td>Outer Join 1: the GDB Event_Summary Table's person_id value joins to the CDS Person Table's person_id value. **</td>
</tr>
</tbody>
</table>

** An outer join returns records from one table that does not have a direct match in the other table.

To Successfully Run This Worksheet Query:
- Premises Table's prem_ID = Event_Summary Table's prem_ID
- Premises Table's prem_state = Event_Summary Table's prem_state
- Premises Table's county = County Table's county

To generate a report with this worksheet, you will fill out the following parameter form.

Below is an excerpt of a printed report generated by this worksheet's query:

<table>
<thead>
<tr>
<th>Prem ID</th>
<th>Event Date Lb</th>
<th>Event Date</th>
<th>Event Ren Lb</th>
<th>Event Ren</th>
<th>NR Pos</th>
<th>NR Neg</th>
<th>Prem Name</th>
<th>Prem City</th>
<th>Pre</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Prem ID</td>
<td>Coll Date:</td>
<td>05-JAN-2000</td>
<td>Test Ren:</td>
<td>DX</td>
<td>0</td>
<td>2</td>
<td>Prem Name</td>
<td>Prem City</td>
</tr>
<tr>
<td>2</td>
<td>Prem ID</td>
<td>Coll Date:</td>
<td>14-FEB-2000</td>
<td>Test Ren:</td>
<td>PS</td>
<td>0</td>
<td>5</td>
<td>Prem Name</td>
<td>Prem City</td>
</tr>
</tbody>
</table>
GDB_CEAH_Market_Total.DIS

<table>
<thead>
<tr>
<th>Workbook's Objective:</th>
<th>This worksheet queries for Brucellosis disease information. It returns the total count of prem_IDs, the sum of the nr_neg, nr_sus, and nr_pos values, and the sum of the number of positive animals.</th>
</tr>
</thead>
</table>
| Workbook Retrieves Data From: | • Premises Table  
• Status Table  
• Any table whose:  
  - prem_ID, prem_name, prem_county  
  - iss_date, rel_date  
  - event_type = TEST  
  and  
  event_rsn = MK, MCI, FP  
  and  
  prem_type = FPC, MKT |
| To Successfully Run This Worksheet Query: | • Premises Table's prem_ID = Status Table's prem_ID  
• Premises Table's prem_state = Status Table's prem_state |

To generate a report with this worksheet, you will fill out the following parameter form.

Below is an excerpt of a printed report generated by this worksheet's query:

<table>
<thead>
<tr>
<th>Distinct PremDs</th>
<th>NR Tested</th>
<th>NR Pos</th>
<th>Disease</th>
<th>Species</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>21</td>
<td>976578</td>
<td>10</td>
<td>BR</td>
</tr>
</tbody>
</table>
### GDB_CEAH_Slaughter_Total.DIS

**Workbook's Objective:**
This worksheet queries for Brucellosis disease information. It returns the total count of prem_IDs, the sum of the nr_neg, nr_sus, and nr_pos values, and the sum of the number of positive animals.

**Workbook Retrieves Data From:**
- Premises Table
- Status Table
- Any table whose:
  - prem_ID, prem_name, prem_county
  - iss_date, rel_date
  - event_type = TEST
  - event_rsn = SL, MCI
  - prem_type = FSL, SSL, CSL, RSP

**To Successfully Run This Worksheet Query:**
- Premises Table's prem_ID = Status Table's prem_ID
- Premises Table's prem_state = Status Table's prem_state

To generate a report with this worksheet, you will fill out the following parameter form.

Below is an excerpt of a printed report generated by this worksheet's query:

<table>
<thead>
<tr>
<th>Distinct PremID</th>
<th>NR Tested</th>
<th>NR Pos</th>
<th>Disease</th>
<th>Species</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>20</td>
<td>5954</td>
<td>4</td>
<td>BR</td>
</tr>
</tbody>
</table>
GDB_CEAH_Status_Pending_List.DIS

| Workbook's Objective: | This worksheet queries for Brucellosis disease information
|                      | This worksheet does not retrieve any records whose:
|                      | status = CERT, ACCRED, FPM, QUAL, VALID, or OTH
|                      | iss_rsn = PMT or HC

<table>
<thead>
<tr>
<th>Workbook Retrieves Data From:</th>
</tr>
</thead>
<tbody>
<tr>
<td>• Premises Table</td>
</tr>
<tr>
<td>• Status Table</td>
</tr>
<tr>
<td>• CDS County Table</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>To Successfully Run This Worksheet Query:</th>
</tr>
</thead>
<tbody>
<tr>
<td>• Premises Table's prem_ID = Status Table's prem_ID</td>
</tr>
<tr>
<td>• Premises Table's prem_county = CDS County Table's county</td>
</tr>
<tr>
<td>• Rel_date = null</td>
</tr>
</tbody>
</table>

To generate a report with this worksheet, you will fill out the following parameter form.

Below is an excerpt of a printed report generated by this worksheet's query:

<table>
<thead>
<tr>
<th>Prem ID</th>
<th>Prem Name</th>
<th>Prem City</th>
<th>County</th>
<th>Status Code</th>
<th>Issue Date Lb</th>
<th>Issue Date</th>
<th>Issue Ren</th>
<th>Issue Entry Date</th>
<th>Remarks</th>
</tr>
</thead>
</table>
GDB_CEAH_Tagsearch.DIS

**Workbook's Objective:**
This worksheet generates a report with data that is pulled from the Sample Table for Brucellosis.

**Workbook Retrieves Data From:**
Sample Table
- prem_id, prem_state, id1, id2, id3, id4, id5, id6, es_nr, test_interp, disease, species

To generate a report with this worksheet, you will fill out the following parameter form. You may enter up to five tag numbers. Each field on the form must be filled in; if you do not need to use a field, you must enter the word **None** instead.

Below is an excerpt of a printed report generated by this worksheet's query:

<table>
<thead>
<tr>
<th>Prem ID</th>
<th>Prem St</th>
<th>Eshtag(id1)</th>
<th>Id1</th>
<th>Id2</th>
<th>Id3</th>
<th>Id4</th>
<th>Id5</th>
<th>Id6</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Prem ID</td>
<td>Eshtag(id1):</td>
<td>72AZF-1927</td>
<td>Backbone(id2):</td>
<td>72JID6206</td>
<td>Id3: NULL</td>
<td>Id4: NULL</td>
<td>Id5: V</td>
</tr>
<tr>
<td>2</td>
<td>Prem ID</td>
<td>Eshtag(id1):</td>
<td>72AZF-7464</td>
<td>Backbone(id2):</td>
<td>72XID1200</td>
<td>Id3: NULL</td>
<td>Id4: NULL</td>
<td>Id5: V</td>
</tr>
</tbody>
</table>
GDB_CEAH_Vactag_Search.DIS

**Workbook's Objective:** This worksheet queries information for Brucellosis for a particular vactag.

**Workbook Retrieves Data From:**
- Premises Table
- Event_Summary Table
- Sample Table

**To Successfully Run This Worksheet Query:**
- Premises Table's prem_ID = Event_Summary Table's prem_ID
- Premises Table's prem_state = Event_Summary Table's prem_state
- Event_Summary Table's es_nr = Sample Table's es_nr
- Event_Summary Table's entry_state = Sample Table's entry_state
- Event_Summary Table's disease = Sample Table's disease

To generate a report with this worksheet, you will fill out the following parameter form. You may enter up to five vactag numbers. Each field on the form must be filled in; if you do not need to use a field, you must enter the word None instead.

Below is an excerpt of a printed report generated by this worksheet's query:

<table>
<thead>
<tr>
<th>Prem ID</th>
<th>Prem St</th>
<th>Id1 Lb</th>
<th>Animal ID1</th>
<th>Id2 Lb</th>
<th>Animal ID2</th>
<th>Id3 Lb</th>
<th>Animal ID3</th>
<th>Es Nr Lb</th>
<th>Es NR</th>
<th>ES Prep</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Prem ID</td>
<td>Prem St</td>
<td>Eartag(d1)</td>
<td>NONE</td>
<td>NULL</td>
<td>Id3:</td>
<td>NULL</td>
<td>13951</td>
<td>730067V</td>
<td>Prem1</td>
</tr>
<tr>
<td>2</td>
<td>Prem ID</td>
<td>Prem St</td>
<td>Eartag(d1)</td>
<td>NONE</td>
<td>Backtag(d2)</td>
<td>NULL</td>
<td>Id3: 11-00921K</td>
<td>20021</td>
<td>596228</td>
<td>Prem1</td>
</tr>
<tr>
<td>3</td>
<td>Prem ID</td>
<td>Prem St</td>
<td>Eartag(d1)</td>
<td>NONE</td>
<td>Backtag(d2)</td>
<td>NULL</td>
<td>Id3: 11-00921K</td>
<td>20021</td>
<td>596228</td>
<td>Prem1</td>
</tr>
</tbody>
</table>
Chapter 6:

Using Discoverer’s Workbook Wizard
Chapter 6: Using Discoverer's Workbook Wizard

This chapter introduces you to an interactive feature in Oracle Discoverer called the Workbook Wizard. This wizard is a tool that you can use to learn how to build a Discoverer workbook and query step-by-step.

The topics covered in this chapter appear below:

<table>
<thead>
<tr>
<th>Topic</th>
<th>See Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Creating a One-Table Query</td>
<td>6.2</td>
</tr>
<tr>
<td>Creating a Two-Table Query</td>
<td>6.18</td>
</tr>
</tbody>
</table>
Creating a One-Table Query

In this exercise, you will learn how to use the interactive Discoverer Workbook Wizard feature to do two tasks:

- Set up a worksheet that contains all of the database items you might want to search for in generating a report
- Create a new search query

Shown below is an SQL statement.

```
1 SELECT prem_id, nr_neg, nr_sus, nr_pos
2 FROM gdb_event_summary
3 WHERE event_type = 'TEST'
4   and species in ('BOV','BIS')
5   and disease = 'BR'
6   and event_date between
       to_date ('01-JAN-2005','dd-mon-yyyy') and
       to_date ('31-JAN-2005','dd-mon-yyyy')
```

In plain English, this SQL statement asks the GDB to generate a list of prem_ids and the number of bovine/bison animals that tested either negative, suspect, or positive for brucellosis testing during January 2005.

The rest of this exercise will show you how to use Discoverer to construct and execute the same query described above. But, instead of using SQL, you will use Discoverer's visual interface and interactive tool, the Workbook Wizard.

1.1 Log in to the Discoverer system by clicking on the connection you’ve created (see page 3.4).

1.2 The **Workbook Wizard, Step 1 of 10** screen will appear.

1.3 Under the first question, click on the **Create a new workbook** option.
1.4 This screen then displays a second prompt, asking you to select a default report layout design for your new worksheet. The layout you choose will be used to format any query results you generate while in this worksheet. For this report, select the **Table** option.

1.5 Click the [Next >] button. The **Workbook Wizard, Step 2 of 10** screen appears. This is the screen on which you will select the columns you want to appear in your report.

1.6 Each yellow folder represents a single GDB table (Premises PR) or a GDB table where all of the available codes have been decoded (PR ALL).

1.7 Click on the plus sign next to the table called **Event Summary ES**. The folder will expand to show all of the fields (data items) in it.
1.8 You now want to move several fields in this folder over from the **Available** column to the **Selected** column.

   a. Click on the item name, **Prem ID**.

   b. Click on the Add button (>) or drag the name to the right. This field now appears in the **Selected** column.

   c. Do Steps a-b above for each field listed below:

      - Nr Neg
      - Nr Sus
      - Nr Pos

1.9 In the **Available** column, click on the minus sign (-) to close the **Event Summary ES** folder.

You have just completed the two mandatory tasks required for each new Discoverer query that you write (selecting a report template and selecting the data items for your workbook).

1.10 At the bottom of the **Workbook Wizard, Step 2 of 10** screen, click [Next]. The next **Workbook Wizard** screen will appear.

1.11 In the **Workbook Wizard, Step 3 of 10** screen, you now see the report layout (**Table**, in this case) that you specified back in Step 1.4.
1.12 In the **Workbook Wizard, Step 3 of 10** screen, you can now change the layout of your default report, if desired.

a. To rearrange the order in which the columns of the report appear, you can click-and-drag a column heading from its original position to another position.

b. To change other features of your report’s appearance, click on [Options…]. A new window appears with two tabbed pages in it.

c. Click on the tab for the **Query Governor** page. On this page, find the **Limit retrieved data query to** option. Next to it, specify the maximum number of rows (records) that you want your report to display.

d. After you have customized all the options desired on these two pages, click [OK]. You go back to the **Workbook Wizard, Step 3 of 10** screen.

1.13 Click [Next ]. The **Workbook Wizard, Step 4 of 10** screen now appears.

1.14 In the **Workbook Wizard, Step 4 of 10** screen, you have the ability to change the appearance of both the column headings of your report (i.e., **Prem ID** or **NR Neg**)) as well as the data that will appear in the rows of the report.

a. Click on the column heading, **NR Pos**.
b. To rename this item, click on the [Edit Heading…] button.

c. In the **Edit Heading** pop-up window (shown at right), change **NR Pos** to **NR Animals Pos**. Then click [OK].

Back in the **Wizard** screen, now click on the item, **Prem ID**.

d. Click on the [Format Heading…] button.

e. In the **Format Heading** pop-up window, you can choose several options to change the appearance of the **Prem ID** column heading. After you have specified all of the options you want, click [OK] to return to the **Wizard** screen.

As this screen shot shows, the text will now appear in bold white letters, the background color of the column heading will be black, and the text alignment will be centered inside the column cell.

![Format Heading Window](image)

f. You can customize the report's data in the same way that you did the report's column headings. To do so, click on the [Format Data…] button.

g. In the **Format Data** pop-up window, there are two tabbed pages, **Format** and one that will be labeled either **Text** or **Number**, depending on the type of field you are formatting. Both tabs contain options you can choose from. Remember, the options you select on these two pages will affect all of the data in every record displayed in your report for that field.
In this screen shot, look at the “Example” field box at the bottom. It indicates that the numerical data for NR Pos will now appear with zero decimal places, a comma separator for multiples of 1000, and negative numbers displayed in black text with a minus sign to the left of the number.

After you have specified all of the options you want on each page, click [OK] to return to the Wizard screen.

1.15 Back in the Wizard screen, click the [Next > ] button. The Workbook Wizard, Step 5 of 10 screen appears.
1.16 On this screen, you will construct the conditions each record must meet in order for your query to return it.

a. Verify that the List conditions for: field is showing All Items.

b. Click on [New…]. The New Condition pop-up window appears.

c. The pointer is in the What description would you like to give your condition? Field. Type in a statement that describes how the search query will filter the data in your worksheet. As an example, type the following: Lists BOV-BR Test events.

d. Use your mouse to stretch the New Condition screen a bit wider so that you can more easily see your query as you construct it line by line.

e. Important: Uncheck the Case-sensitive option in the lower-left corner of the New Condition screen. In most queries you'll write, there should be no check mark appearing in this box.

(Most data stored in the GDB is stored in uppercase letters. If any values for a condition are entered in lowercase letters while this Case-sensitive option is checked, then no GDB data will be found and displayed in the output report.)

Note: Be sure to do Step 1.15e above. If you do not, any reports you generate with this search query may be incomplete.

f. Click on [Advanced>>] to start building your search query by creating the first condition for it. Clicking the [Advanced>>] button simply allows you to enter multiple items for your condition.
i. In the **Item** column, click the down arrow to make a drop-down list appear. In this list, you will see all of the items you selected in step 2; however, you can create conditions based on items you did not select by clicking on the **Select Item…** entry in the drop-down list. Find and select the **Event Type** field.

ii. In the **Condition** column, verify that an equal sign (=) is displayed.

iii. In the **Values** column, type **TEST** directly into the blank field.

Your query should now look like this:

<table>
<thead>
<tr>
<th>Item</th>
<th>Condition</th>
<th>Values</th>
</tr>
</thead>
<tbody>
<tr>
<td>Event Type</td>
<td>=</td>
<td>TEST</td>
</tr>
</tbody>
</table>

**g. To create the second condition, click on [New Item].**

i. In the **Item** column for this second condition, click the down arrow, select **Select Item…**, and select **Species**.

ii. In the **Condition** column, click on the down arrow and select the **IN** operator from the drop-down list (note: all of the operators will be discussed in detail in Chapter 9).

iii. In the **Values** column, type **BOV** directly into the blank field. Follow this with a comma, and then type **BIS**. Note that you do not need to type single quotes in; Discoverer will add single quotes when you click in another field.

iv. Your search query should now look like this:

<table>
<thead>
<tr>
<th>Group</th>
<th>Item</th>
<th>Condition</th>
<th>Values</th>
</tr>
</thead>
<tbody>
<tr>
<td>AND</td>
<td>Event Type</td>
<td>=</td>
<td>TEST</td>
</tr>
<tr>
<td>AND</td>
<td>Species</td>
<td>IN</td>
<td>'BOV', 'BIS'</td>
</tr>
</tbody>
</table>

**h. To create the third condition, click on [New Item] again.**

i. In the **Item** column, click the down arrow, select **Select Item…**, and click on **Disease**.

ii. In the **Condition** column, verify that an equal sign (=) is displayed.

iii. In the **Values** column, type **BR**

So far, your query should look like this:
i. Create the fourth condition. Click on [New Item].
   i. In the Item column for this third condition, click the down arrow and select **Event Date**.
   ii. In the Condition column, select the **BETWEEN** operator.
   iii. In the Values column, type '01-JAN-2005' into the first block, and type '31-JAN-2005' into the second block.

Note: Whenever you need to enter a date value into a Discoverer parameter form, be sure to use the Oracle format for entering dates. This format is DD-MON-YYYY, where
   DD are the two digits for the day
   MON are the first three letters of the month's name
   YYYY are the four digits for the year

*Example:* 06-SEP-2003

Your query should now look like this:

You have finished constructing your query.

iv. Click the [Next] button. The next **Workbook Wizard** screen will appear.

1.17 You will see the **Workbook Wizard, Step 6 of 10** screen.

In this screen, you can specify which items you want your report results to be sorted by. If you select multiple items to use as sorting criteria, you can assign a priority level to each item.
a. Click [Add]. One of the items in your worksheet appears.

b. Select Prem ID from the list.

c. You may customize this item's sorting Direction by changing from Low to High to High to Low.

d. You may also change the “Group” column to group sort

e. When you have finalized your sorting criteria, click [Next]. The next Workbook Wizard screen will appear.

1.18 In the Workbook Wizard, Step 7 of 10 screen (shown below), you can apply a calculations definition to one or more items.
(The search query you are currently constructing does not contain any data points that would use a calculation definition. So the rest of this step is just informative. Read it, or skip directly to Step 1.19, as you wish.)

a. Click [New…]. A **New Calculation** window (shown below) will appear.
b. If you wish, try out the options in this window.
c. When you have finished, click the [Cancel] button to exit without saving your work. You are returned to the **Wizard** screen.
d. Click [Next ]. The next **Workbook Wizard** screen will appear.
1.19 In the **Workbook Wizard, Step 8 of 10** screen, you can apply a percentage definition to one or more items. (The search query you are currently constructing does not contain any data points that could use a percentage definition. So the rest of this step is just informative.)

![Workbook Wizard, Step 8 of 10: Percentages](image)

a. Click [New…]. A **New Percentage** window will appear.

b. Try out the options in this window to apply a percentage definition to a data point. Then click [Cancel] to return to the **Wizard** screen.

c. Click [Next ]. The **Workbook Wizard, Step 9 of 10** screen will appear.
1.20 In the **Workbook Wizard, Step 9 of 10** screen, you can apply a totals definition to one or more items.

![Workbook Wizard, Step 9 of 10: Totals](image)

a. Click [New…]. A **New Total** window (shown below) will appear.

b. Under **Which data point would you like to create a total on?**, select **NR Pos**.

![New Total](image)
c. Under **What kind of total do you want?**, select **sum**. This will add all of the values in the **NR Pos** column to give you a grand total.
d. There are other options in this window, but they are not needed for the current search query.
e. Click [OK] to return to the **Wizard** screen. Your new totals definition now appears on this screen.
f. Click [Next]. The final **Workbook Wizard** screen will appear.

1.21 In the **Workbook Wizard, Step 10 of 10** screen, you can apply a parameter definition to an item.

a. You can do either of two tasks:
   - Select an existing parameter shown in the Available Parameters list. Then click [Edit...].
   - Click [New...] if you want to add a new parameter to your search query.
An **Edit Parameter** or **New Parameter** window will appear.

b. Fill out the fields in this window as desired.

c. Click [OK] to return to the **Wizard** screen. Your new or revised parameter definition now appears on this screen.

Click [Finish]. Your search query will be executed immediately. Any search results found will be displayed in the default report format you chose.

An example **Results Screen** like the one shown below will be displayed in your worksheet.
1.23 After doing all this work, be sure to save your search query/workbook.

Before doing so, check with your database administrator first. He or she may have set up Discoverer so that your office has both state-level and personal-level accounts. In such a case, your administrator may ask you to always create and save new workbooks to your personal Discoverer account only.

a. In the Discoverer menu bar, select the File→Save command. The following Save Workbook to Database pop-up window will appear.

b. In the New name text field, enter the name you want your search query/workbook to be saved under.

Be careful to give your new workbook a unique name. Do not save it under a generic name, such as Workbook1.

(There are many other individuals who will also be using this Discoverer product on the same GDB database. If several people save their workbooks under the same name, these same workbook files will be overwritten each time.)

It is recommended that your office set up guidelines or naming conventions for its Discoverer files and workbooks. Several naming conventions are suggested below:

<table>
<thead>
<tr>
<th>Intended Use of Naming Convention</th>
<th>Syntax of Naming Convention</th>
<th>Examples</th>
</tr>
</thead>
<tbody>
<tr>
<td>For an individual's workbooks</td>
<td>Individual's name_description or date of workbook</td>
<td>Harris_premid_workbook1, Strathburg_year2002, Bruce_tb_farms_2001</td>
</tr>
<tr>
<td>For workbooks shared by everyone in an office</td>
<td>GDB Business Area_rpt_office or state_description of workbook</td>
<td>BR_rpt_cincinnati_premid, PRV_rpt_AZ_fed_2003</td>
</tr>
</tbody>
</table>
Creating a New Two-Table Query

In Structured Query Language (SQL), one of the most difficult tasks to perform is to create a query that pulls data from two (or more) tables. One reason this is difficult is that the tables that are being queried must be ‘joined’, which involves specifying which fields on the first table link to which fields on the second table. It becomes even more complex when additional tables are added to the query.

Discoverer makes this task much easier to perform. Since the table joins have to be set up ahead of time by the Discoverer Administrator, you don’t have to worry about how to join tables together; all you have to do is pick the tables you want to query data on. After you pick the first table, only those tables that are join-able to the first table are selected, and all others are grayed out.

When you select the second table (as well as each subsequent table), you will see a screen similar to the following one, which asks whether you want to perform an “inner” or an “outer” join between those tables.

![Join Folders dialog box](image)
In this example, items from the **Event_Summary** table were selected first, followed by items from the **Sample** table. The first selection, **ES -> SA**, refers to an inner join, while the second selection, **ES -> SA missing as null**, refers to an outer join. The type of join you select will greatly affect the data you see when you run your query.

With an inner join, records from the first table will only be displayed if there is at least one corresponding (linked) record on the second table. So, for example, the information from the **Event_Summary** table will only be shown if that **Event_Summary** record has at least one corresponding **Sample** record. If there are no **Sample** records associated with that **Event_Summary**, then the **Event_Summary** record will not be displayed either. If, on the other hand, there are multiple **Sample** records associated with that **Event_Summary** record, then the information that is stored on the **Event_Summary** table will be listed multiple times: once for each **Sample** record.

An outer join, on the other hand, will list an **Event_Summary** record regardless of whether or not an associated **Sample** record exists. If there is no associated **Sample** record, then the data from the **Event_Summary** table will be displayed, and the missing **Sample** field will be displayed as null (hence the term “missing as null” when choosing an outer join).

Here is an example of report output using an inner join:

<table>
<thead>
<tr>
<th>Es Nr</th>
<th>Event Type</th>
<th>Test Interp</th>
<th>Id1</th>
<th>Id2</th>
</tr>
</thead>
<tbody>
<tr>
<td>1 20070939785</td>
<td>VAC-C</td>
<td>N</td>
<td>84\VTX4519</td>
<td>NULL</td>
</tr>
<tr>
<td>2 20070939786</td>
<td>VAC-C</td>
<td>N</td>
<td>84\VWA9330</td>
<td>84\VWA9348</td>
</tr>
<tr>
<td>3 20070939787</td>
<td>VAC-C</td>
<td>N</td>
<td>84\VVD5966</td>
<td>NULL</td>
</tr>
<tr>
<td>4 20070939788</td>
<td>VAC-C</td>
<td>N</td>
<td>84\VVD5967</td>
<td>84\VVD6000</td>
</tr>
</tbody>
</table>

In this query, the es_nr and event_type are pulled from the **Event_Summary** table; while test_interp, id1 and id2 are pulled from the **Sample** table. Note that every row in the report has at least one field from the **Sample** table which is not null.
Next, take a look at the output from the same report; the only difference here is that an outer join was used instead of an inner join:

<table>
<thead>
<tr>
<th>No.</th>
<th>Es Nr</th>
<th>Event Type</th>
<th>Test Interp</th>
<th>Id1</th>
<th>Id2</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>20070939777</td>
<td>TEST</td>
<td>NULL</td>
<td>NULL</td>
<td>NULL</td>
</tr>
<tr>
<td>2</td>
<td>20070939778</td>
<td>TEST</td>
<td>NULL</td>
<td>NULL</td>
<td>NULL</td>
</tr>
<tr>
<td>3</td>
<td>20070939779</td>
<td>TEST</td>
<td>NULL</td>
<td>NULL</td>
<td>NULL</td>
</tr>
<tr>
<td>4</td>
<td>20070939780</td>
<td>TEST</td>
<td>NULL</td>
<td>NULL</td>
<td>NULL</td>
</tr>
<tr>
<td>5</td>
<td>20070939781</td>
<td>TEST</td>
<td>NULL</td>
<td>NULL</td>
<td>NULL</td>
</tr>
<tr>
<td>6</td>
<td>20070939782</td>
<td>TEST</td>
<td>NULL</td>
<td>NULL</td>
<td>NULL</td>
</tr>
<tr>
<td>7</td>
<td>20070939785</td>
<td>VAC-C</td>
<td>N</td>
<td>84\VTX4519</td>
<td>NULL</td>
</tr>
<tr>
<td>8</td>
<td>20070939786</td>
<td>VAC-C</td>
<td>N</td>
<td>84\VWA9330</td>
<td>84\VWA9348</td>
</tr>
<tr>
<td>9</td>
<td>20070939787</td>
<td>VAC-C</td>
<td>N</td>
<td>84\VD5966</td>
<td>NULL</td>
</tr>
</tbody>
</table>

Notice that in this report, there are several rows that show all three fields that are pulled from the Sample table as “NULL”; these are records that only appear when using an outer join.
Chapter 7:
Using Discoverer to Create a New Ad Hoc Query
Chapter 7: Using Discoverer to Create a New Ad Hoc Query

If you want to create a new search query without using Discoverer's Workbook Wizard or a pre-defined workbook, then this chapter is for you. It will introduce you to Discoverer’s Edit Worksheet feature, which enables you to write new worksheet queries unassisted.

The topics covered in this chapter appear below:

<table>
<thead>
<tr>
<th>Topic</th>
<th>See Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Creating a New Ad Hoc Worksheet query Unassisted</td>
<td>7.2</td>
</tr>
<tr>
<td>Printing Reports from a Worksheet query</td>
<td>7.31</td>
</tr>
</tbody>
</table>
Creating a New Ad Hoc Worksheet Query Unassisted

In this exercise, you will learn how to build a new worksheet query using a single feature, the **Edit Worksheet** Screen. On this one screen, you can access the entire set of dialog boxes that you would otherwise execute one step at a time if you were using the Workbook Wizard instead.

To provide a running example, we will use Discoverer to create a search query that retrieves the same results as the following SQL statement:

```sql
1 SELECT prem_id, nr_neg, nr_sus, nr_pos
2 FROM gdb_event_summary
3 WHERE event_type = 'TEST'
4   and species in ('BOV','BIS')
5   and disease = 'BR'
6   and event_date between
7*   to_date ('&begindate','dd-mon-yyyy') and
     to_date ('&enddate','dd-mon-yyyy')
9   and event_rsn = 'OTH'
```

In plain English, this SQL statement asks the GDB to generate a list of prem_ids and the number of bovine/bison animals that tested either negative, suspect, or positive for brucellosis in private sale-testing. If you were to execute this SQL statement, the GDB would prompt you to specify the beginning and ending dates of the time period for the data you want to retrieve.
1.1 If you have:

- not yet logged into Discoverer's website, do so now by following the steps below:
  
i. At your computer desktop screen, launch your web browser.

  ii. In the browser's **Location** or **Address** field, enter the following URL for Discoverer's website:

  http://mdrdoras54:7783/discoverer/plus?

  A **Connect to Discoverer Plus Screen** will appear.

  iii. In the table’s **Connection** column, click once on the hyperlink for the connection you want to use.

  A **You are connecting to OracleAS Discoverer Screen** appears next.

  iv. Enter your password, then click once on **Connect**.

  v. Now go directly to Step 1.2 below.

- already logged into Discoverer's website, do the following:
  
i. Close the workbook you might currently be working in.

  ii. In the Discoverer menu bar, select the **File → New** menu item.

  iii. Go directly to Step 1.3 now.

1.2 In the **Workbook Wizard, Step 1 of 10** screen, you will see the prompt shown at right.

a. Answer this prompt by clicking on the option, **Create a new workbook**.

b. Go on to Step 1.3.
1.3 You now see a prompt (shown below), asking you to select a default report layout design for your new worksheet query.

The layout you choose will be used to format any query results you generate while in this worksheet. You can click on each option to see a graphic of how that report format will look. (And you will be able to customize this report layout later.)

a. For the purposes of this exercise, select the Table option.
b. Click on [Next].

1.4 The Workbook Wizard, Step 2 of 10 screen (shown below) now appears.
This screen is the **Item Selector Screen**. Each time you create a new workbook, you will use this screen to specify which data items you want to use in the workbook. Think of your workbook as a folder in which you store every possible data item that you might need to generate reports about.

a. In the **Available** data field, click on the down arrow.

b. Click once on the **VS_CEAH_GDB** option (see right).

c. The contents of the **Available** column will change to display all tables and data items contained in the **VS_CEAH_GDB** Business Area.

1.5 Click on the plus sign (+) next to the **Event Summary ES** table folder to open it. The folder will expand to show all of the fields (data items) in it.
1.6 You now want to copy several fields in this folder over to the **Selected** column.

   a. Click on the item name, **Prem ID**.

   b. Click on the Add button (>). as shown at right. This field now appears in the **Selected** column.

   c. Do Steps a-b above for each field listed below:

   - ES Nr Neg
   - ES Nr Sus
   - ES Nr Pos

1.7 In the **Available** column, click on the minus sign (-) next to the **Event Summary ES** folder to close it.

   Your workbook’s **Selected** column should now look like the example shown at right.

   ![Selected Column Example](image)

You have just completed the two mandatory tasks required for each new Discoverer query that you write (selecting a report template and selecting the data items for your workbook).

1.8 You now want to exit the **Workbook Wizard** so that you can pick and choose the remaining query-writing tasks that you want to do.

   a. Click on [Finish]. Discoverer will immediately try to execute this query.

   b. You may get an error message, saying that **Not all rows have been retrieved. Data may be inaccurate**. Click on [OK].

   c. You may or may not see some results displayed in your workbook. Ignore these results for now.
1.8.5 …Mention the need to set access-state security permissions at this point…

1.9 Do one of the following commands:
   - In the Discoverer menu bar, select the **Sheet ➔ Edit Sheet** menu item.
   - In the Discoverer tool bar, click on the **Edit Worksheet** icon symbol (identified by the pointer below).

1.10 The **Edit Worksheet Screen** now appears. Note the set of tabs across the top of the screen. Each tab represents one dialog box that you can open and use to set up your worksheet query’s properties.

   ![Edit Worksheet Screen](image)

   **Tip:** If the labels on the tabs appear cut off (as shown in the example above), use your cursor to stretch the right edge of the **Edit Worksheet Screen** horizontally until you can see the full labels on the tabs.

   On this screen, you can see the following:
   - The **Select Items** tabbed dialog box is already open and active. In its **Selected** column, you should see the data items that you specified back in Steps 1.4-1.6. This means that you have already finished your work in the **Select Items** dialog box.
   - The remaining tabbed dialog boxes (**Table Layout, Format, Conditions, Sort, Calculations, Percentages, Totals, and Parameters**) are considered optional, in that you can complete any of them depending on the query you are writing.
1.11 At this point, you should set any printing parameters for how data should be displayed in either the electronic worksheet or hardcopy printout.
   a. On the Edit Worksheet Screen, click on [Options].
   b. In the Options Screen, you will see two tabs. Click on the Query Governor tab.
   c. In the Query Governor page, verify that a check mark appears to the left of the Limit retrieved query data to field. Then enter a number in this field that represents the maximum number of rows (records) you want your query to display.
   d. Click on the Sheet Format tab.
   e. In the Sheet Format page, enter the number you want in the Rows per screen page field. The number you enter will determine how many rows will appear on a worksheet page before the results need to be carried over to additional pages.
   f. Click [OK]. You now return to the main Edit Worksheet Screen.

1.12 At this point, you can choose which dialog boxes in the Edit Worksheet Screen you want to use next to configure your worksheet.

<table>
<thead>
<tr>
<th>Name of Dialog Box</th>
<th>Description of Dialog Box</th>
<th>Go To This Step</th>
</tr>
</thead>
<tbody>
<tr>
<td>Table Layout</td>
<td>You can configure the arrangement of the columns in a report. Any changes you make here will override the report template for the entire workbook.</td>
<td>1.13</td>
</tr>
<tr>
<td>Format</td>
<td>You can configure formatting options for the headings and data within a specific worksheet. Any changes you make here will override the report template for the entire workbook.</td>
<td>1.14</td>
</tr>
<tr>
<td>Conditions</td>
<td>You can apply a filter to a data item in order to limit the number of records your query will retrieve.</td>
<td>1.15</td>
</tr>
<tr>
<td>Sort</td>
<td>You can specify the criteria used by Discoverer to arrange a worksheet's results within a particular column, in either ascending or descending order.</td>
<td>1.16</td>
</tr>
<tr>
<td>Calculations</td>
<td>You can assign expressions (mathematical formulas, for example) to data items in your query.</td>
<td>1.17</td>
</tr>
<tr>
<td>Percentages</td>
<td>You can apply this specific calculation type to either subtotals or grand totals in a worksheet's results.</td>
<td>1.18</td>
</tr>
<tr>
<td>Totals</td>
<td>You can add calculations to a worksheet query in order to summarize or average the values in a specific column.</td>
<td>1.19</td>
</tr>
<tr>
<td>Parameters</td>
<td>You can customize various values within a condition. This lets you change conditions without changing the query.</td>
<td>1.20</td>
</tr>
</tbody>
</table>
1.13 Click on the **Table Layout** tab to open the **Table Layout** dialog box (shown below):

Use this dialog box to customize the layout of your default report.

a. To re-arrange the order in which the columns of the report appear, you can click-and-drag a column heading from its original position to another position. Feel free to try this now.

b. If you:
   - Need to complete another dialog box, click on the appropriate tab for that dialog box.
   - Have completed all of the dialog boxes needed for constructing your search query, go directly to Step 1.21 now to learn how to run this query.
1.14 Click on the **Format** tab to open the **Format** dialog box (shown below):

![Format Dialog Box]

In this dialog box, you can customize the appearance of both the column headings of your report (i.e., **Prem ID** and **NR Neg** in the screen shot below) as well as the data that will appear in the rows of the report.

Remember that for this exercise, your report format is currently set to the “Table” format and looks similar to the screen image shown back in Step 1.13.

- a. Click once on the column heading, **NR Pos**.
- b. To rename this heading, click on the [Edit Heading…] button.
- c. In the **Edit Heading** pop-up window (shown at right), change **NR Pos** to **NR Animals Pos**. Then click [OK].

![Edit Heading Dialog Box]

Back in the **Format** dialog box, you can see this change in the **Example** field.

- d. Now click on the item, **Prem ID**
- e. Click on the [Format Heading…] button.
f. In the **Format Heading** pop-up window, choose the options indicated below to change the appearance of the **ES Prem ID** column heading.
   - Make the text appear in white letters.
   - Make the background color of the column heading dark (blue).
   - Use Dialog as the font type, bold as the font style, and 10 pt as the font size.
   - Center the text inside the column cell.

All of these options are indicated in the following screen shot:

![Format Heading](image)

After you have specified all of the options you want, click [OK] to return to the **Format** dialog box. Again, check the **Example** field to see what this modified heading will look like.

---

g. You can customize the report's data in the same way that you did the report's column headings. To do so, click on the [Format Data…] button.

h. In the **Format Data** pop-up window, there are two tabbed pages, **Format** and **Text**. Both contain a variety of options for you to use. Remember, the options you select on these two pages will affect all of the data in every record displayed in your report.
In the example at right, various options were selected on both the **Format** and **Text** tabbed dialog boxes. The result is that all text data in any query results will appear in red uppercase letters, using the DialogInput font type and 10 pt. font size.

After you have specified all of the options you want on each page, click [OK] to return to the **Format** dialog box within the **Edit Worksheet Screen**.

i. If you:
   - Need to complete another dialog box, click on the appropriate tab for that dialog box.
   - Have completed all of the dialog boxes needed for constructing your search query, go directly to Step 1.21 now to learn how to run this query.
Click on the **Conditions** tab to open the **Conditions** dialog box (shown below):

On this screen, you will construct the actual search query itself, by creating several condition statements:

a. Verify that the **List conditions for:** field is showing **All Items**.

b. Click on [New…]. The **New Condition** pop-up window appears.
c. The cursor is in the **What description would you like to give your condition?** field. Type in a statement that describes how the search query will filter the data in your worksheet.

As an example, type the following:

*Lists BOV-BR test results, sorted by their prem IDs.*

d. Use your mouse to stretch the **New Condition** screen a bit wider so that you can more easily see your query as you construct it line by line.

e. **Important:** Uncheck the **Case-sensitive** option in the lower-left corner of the **New Condition** screen. There should be no check mark appearing in this box.

(There is a reason why you did this. Most data stored in the GDB is stored in uppercase letters. If any prompts for starting a query are entered in lowercase letters while this **Case-sensitive** option is checked, then no GDB data will be found and displayed in the output report.)

---

**Note:** Be sure to do Step 1.15e directly above. If you do not, any reports you generate with this search query may be incomplete.

f. Click on [Advanced>>] to start building your search query by creating the first condition for it within the **Formula** block.

i. In the **Item** column, click on the down arrow to make a dropdown list appear. Click on **More Items** to expand the list. In this list, find and select the **Event Type** field. Click on [OK].

ii. In the **Condition** column, verify that an equal sign (=) is displayed.

iii. In the **Values** column, manually type ‘TEST’. (Be sure to include the single quotes before and after TEST as you type.)

Your query should now look like this:
g. To create the second condition, click on [New Item] again.
   i. In the Item column for this second condition, click on the down arrow, click on More Items, and select Species.
   ii. In the Condition column, click on the down arrow and select the IN operator from the drop-down list.
   iii. In the Values column, manually type 'BOV', directly into the Values field. (Be sure to include the single quotes before and after BOV as you type. Also include the comma and one space after the second single quote.)
   iv. Again in the Values column, manually type 'BIS' directly into the Values field. (Be sure to include the single quotes before and after BIS as you type.)

Your search query should now look like this:

```
<table>
<thead>
<tr>
<th>Group</th>
<th>Item</th>
<th>Condition</th>
<th>Values</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Event Type</td>
<td>=</td>
<td>“TEST”</td>
</tr>
<tr>
<td>AND</td>
<td>Species</td>
<td>IN</td>
<td>“BOV, BIS”</td>
</tr>
</tbody>
</table>
```

h. To create the third condition, click on [New Item] again.
   i. In the Item column, select Disease.
   ii. In the Condition column, verify that an equal sign (=) is displayed.
   iii. In the Values column, type ‘BR’.

```
<table>
<thead>
<tr>
<th>Group</th>
<th>Item</th>
<th>Condition</th>
<th>Values</th>
</tr>
</thead>
<tbody>
<tr>
<td>AND</td>
<td>Event Type</td>
<td>=</td>
<td>“TEST”</td>
</tr>
<tr>
<td></td>
<td>Species</td>
<td>IN</td>
<td>“BOV, BIS”</td>
</tr>
<tr>
<td></td>
<td>Disease</td>
<td>=</td>
<td>“BR”</td>
</tr>
</tbody>
</table>
```

i. Create the fourth condition. (You may want to make the New Condition dialog box both wider and taller so that you can better see your work.)
   i. Click on [New Item].
   ii. In the Item column for this fourth condition, select Event Date.
   iii. In the Condition column, select the BETWEEN operator.
iv. In the Values column, click on the first down arrow and select the New Parameter option. A New Parameter window will appear.

   a. In the What do you want to name this parameter? text field, type Event Begin Date.

   b. In the What prompt do you want to show other users? text field, type Enter the event's starting date:.

   c. Do not type anything in the What default do you want to give this parameter? text fields.

   d. Click [OK]. You return to the New Condition screen.

v. In the What do you want to name this parameter? text field, type Event End Date. In the Values column again, click on the second down arrow and select the New Parameter option. The New Parameter window will appear again.

   a. In the What prompt do you want to show other users? text field, type Enter the event's ending date:.

   b. Click [OK]. You return to the New Condition screen.

   c. Click [OK]. You return to the New Condition screen.

   Your query should now look like this:
j. Create the fifth and last condition. Click on [New Item].
   i. In the Item column for this fifth condition, select Event Rsn.
   ii. In the Condition column, verify that an equal sign (=) is displayed.
   iii. In the Values column, type 'OTH'.

You have finished constructing your query. It should look like this:
iv. Click the [OK] button to return to the **Conditions** dialog box within the **Edit Worksheet Screen**. You now see the new Condition statement that you just created.

![Conditions dialog box](image)

k. If you:

- Need to complete another dialog box, click on the appropriate tab for that dialog box.

- Have completed all of the dialog boxes needed for constructing your search query, go directly to Step 1.21 now to learn how to run this query.
1.16 Click on the Sort tab to open the Sort dialog box (shown below):

In this screen, you can specify which items you want your report results to be sorted by. If you select multiple items to use as sorting criteria, you can assign a priority level to each item.

a. Click on [Add].

b. In the Column column, click on the down arrow to display a list containing the items in your worksheet. In this list, select Prem ID.

c. In the Direction column, change this item's sorting arrangement from Low to High to High to Low. This means that a set of alphabetical results would be sorted Z→A, while a set of numerical results would be sorted 10→1.

d. In the Sort Type column, click on the Group Sort option. Doing so changes this item from a straightforward sort to a group sort, in which the results are split into groups based on similar values (such as the same year, the same geographic location, etc.).
Your **Sort** tabbed page should now look like this:

![Edit Worksheet](image)

Click Add and then select a column to sort. Select the Group sort type to hide repeated cell values in a column. Check Hidden to hide a sorted column in the worksheet.

---

e. If you:

- Need to complete another dialog box, click on the appropriate tab for that dialog box.

- Have completed all of the dialog boxes needed for constructing your search query, go directly to Step 1.21 now to learn how to run this query.
1.17 Click on the **Calculations** tab to open the **Calculations** dialog box (shown below):

In this dialog box, you can apply a calculations definition to one or more items.

(The search query you are currently constructing does not contain any data points that would use a calculation definition. So the rest of this step is just informative. Read it, or skip directly to Step 1.19, as you wish.)

a. Click [New…]. A **New Calculation** window (shown below) will appear.
b. Try out the options in this window. Then click [Cancel] to exit without saving your work. You are returned to the **Calculations** dialog box.

c. If you:

- Need to complete another dialog box, click on the appropriate tab for that dialog box.

- Have completed all of the dialog boxes needed for constructing your search query, go directly to Step 1.21 now to learn how to run this query.
1.18 Click on the **Percentages** tab to open the **Percentages** dialog box (shown below):

![Percentages dialog box](image)

In this dialog box, you can apply a percentage definition to one or more items. (The search query you are currently constructing does not contain any data points that could use a percentage definition. So the rest of this step is just informative.)

a. Click [New…]. A **New Percentage** window will appear.

   (Because the search query you are currently constructing does not contain any data points, you should see an error message instead of the **New Percentage** window.)

b. If you do see the **New Percentage** window, feel free to try out the options in this window. Then click [Cancel] to exit without saving your work. You are returned to the **Percentages** dialog box.

c. If you:
   - Need to complete another dialog box, click on the appropriate tab for that dialog box.
   - Have completed all of the dialog boxes needed for constructing your search query, go directly to Step 1.21 now to learn how to run this query.
1.19 Click on the **Totals** tab to open the **Totals** dialog box (shown below):

![Totals dialog box](image)

In this dialog box, you can apply a totals definition to one or more items.

a. Click [New…]. A **New Total** window (shown below) will appear.

![New Total window](image)

b. Under **Which data point would you like to create a total on?**, select **Nr Neg**.
c. Under **Do you want to calculate totals within each page?**, select **Calculate totals within each page**.

d. There are other options in this window, but they are not needed for the current search query.

e. Click [OK] to return to the **Totals** dialog box. Your new totals definition (shown below) now appears on this screen.

![Edit Worksheet dialog box](image)

f. If you:
   - Need to complete another dialog box, click on the appropriate tab for that dialog box.
   - Have completed all of the dialog boxes needed for constructing your search query, go directly to Step 1.21 now to learn how to run this query.
1.20 Click on the **Parameters** tab to open the **Parameters** dialog box (shown below):

![Parameters dialog box](image)

In this dialog box, you can create, apply, and edit a parameter definition to an item.

(However, for the search query you are currently constructing, you already did this work back in Step 1.15 when you created your query conditions. That is why you can see two parameters listed in the **Available parameters** field. So the rest of this step is just informative.)

a. You can do either of two tasks:

   - Edit a parameter that already exists in your search query. To do this task, highlight one of the parameter shown in the **Available parameters** list. Then click [Edit…].
   
   - Add a new parameter to your search query. To do this task, click [New…].
An **Edit Parameter** (shown below) or **New Parameter** window will appear.

b. Fill out the fields in this window as desired.

c. Click [OK] to return to the **Parameters** dialog box. Your new or revised parameter definition now appears on this screen.

d. If you:

   - Need to complete another dialog box, click on the appropriate tab for that dialog box.
   - Have completed all of the dialog boxes needed for constructing your search query, go directly to Step 1.21 now to learn how to run this query.
1.21 You are now ready to run your new search query. In any of the tabbed dialog boxes within the **Edit Worksheet Screen**, click on [OK].

Discoverer will start running your search query by displaying a prompt window (see below). This window contains the two prompts that you originally created back in Step 1.15.

![Edit Parameter Values](image)

**Note:** Whenever you need to enter a date value into a Discoverer parameter form, be sure to use the Oracle format for entering dates. This format is **DD-MON-YYYY**, where:
- DD are the two digits for the day
- MON are the first three letters of the month's name
- YYYY are the four digits for the year

**Example:** 06-SEP-2003

a. Specify the date range that you want your report to cover by answering the two prompts, as shown below.

b. Click [OK]. Your search query will be executed immediately. Any search results found will be displayed in the default report format you chose.
A **Results Screen** like the one shown below will appear in your worksheet.

![Results Screen](image)

1.22 After doing all this work, be sure to save your search query/workbook.

Before doing so, check with your database administrator first. He or she may have set up Discoverer so that your office has both state-level and personal-level accounts. In such a case, your administrator may ask you to always create and save new workbooks to your personal Discoverer account only.

a. In the Discoverer menu bar, select the **FileÆSave** command. The following **Save Workbook to Database** pop-up window will appear.

b. In the **New name** text field, enter the name you want your search query/workbook to be saved under.

Be careful to give your new workbook a unique name. Do not save it under a generic name, such as **Workbook1**.

(There are many other individuals who will also be using this Discoverer product on the same GDB database. If several people save their workbooks under the same name, these same workbook files will be overwritten each time.)
It is recommended that your office create a set of naming convention guidelines for its Discoverer workbooks and reports. Some suggestions appear below:

<table>
<thead>
<tr>
<th>Intended Use of Naming Convention</th>
<th>Syntax of Naming Convention</th>
<th>Examples</th>
</tr>
</thead>
<tbody>
<tr>
<td>For an individual's workbooks</td>
<td>Individual's name_description or date of workbook</td>
<td>Harris_premid_workbook1</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Strathburg_year2002</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Bruce_tb_farms_2001</td>
</tr>
<tr>
<td>For workbooks shared by everyone in an office</td>
<td>rpt_office or state_description of workbook</td>
<td>rpt_cincinnati_premid</td>
</tr>
<tr>
<td></td>
<td></td>
<td>PRV_rpt_AZ_fed_2003</td>
</tr>
</tbody>
</table>
Printing Reports from a Worksheet Query

In this exercise, you will learn how to use the interactive Discoverer Print Wizard tool to print reports which contain the results of a worksheet query.

1.1 Open the worksheet whose results you want to print.

1.2 In the Discoverer menu bar, select the File → Print menu item. The Print Wizard, Step 1 of 3 screen will appear.

1.3 In this screen, there are two prompts for you to specify your preferences:

   - You can print either the worksheet currently displayed onscreen or the entire workbook that includes the current worksheet.
   - You can print the results in any of several formats: as a graph alone, as a table/crosstab alone, or as both a graph and table/crosstab.

Specify your preferences, then click [Next>] . The Print Wizard, Step 2 of 3 screen will appear.

1.4 If one of the report formats you wanted was a graph, you will see prompts asking how you want to customize it. Answer these prompts, then click [Next>].
1.5 The **Print Wizard, Step 2 of 3** screen now prompts you to enter the values that the search query will be executed on.

After entering these values, click on [Next>]. The **Print Wizard, Step 2 of 3** screen will then appear.

![Print Wizard Step 3 of 3: Supervise](image)

1.6 In this screen, choose whether you want to supervise the printing process or not. Then click on [Finish].

1.7 You now see a **Print** dialog box, in which you can specify the printer/plotter you want to use as well as any printing properties you want applied to the hardcopy printout itself.

After you have specified all the options in this dialog box, click on [OK] or [Finish] or [Done] or [Run] (or any other appropriate command). Discoverer will execute the query and print it out according to your specifications.
Chapter 8:
Managing Your Discoverer Workbooks
Chapter 8: Managing Your Discoverer Workbooks

Once you start writing and executing Discoverer queries, you will quickly build up a collection of workbooks that need to be managed. This chapter provides the procedures you should use for these administrative-type tasks.

The topics covered in this chapter appear below:

<table>
<thead>
<tr>
<th>Topic</th>
<th>See Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Workbook-Related Tasks:</td>
<td>8.2</td>
</tr>
<tr>
<td>• Creating a New Workbook</td>
<td>8.2</td>
</tr>
<tr>
<td>• Saving a New Workbook</td>
<td>8.4</td>
</tr>
<tr>
<td>• Duplicating an Existing Workbook</td>
<td>8.5</td>
</tr>
<tr>
<td>• Opening an Existing Workbook</td>
<td>8.6</td>
</tr>
<tr>
<td>• Deleting an Existing Workbook</td>
<td>8.7</td>
</tr>
<tr>
<td>Worksheet-Related Tasks:</td>
<td>8.8</td>
</tr>
<tr>
<td>• Adding a New Worksheet to an Existing Workbook</td>
<td>8.8</td>
</tr>
<tr>
<td>• Renaming a Worksheet</td>
<td>8.10</td>
</tr>
<tr>
<td>• Refreshing the Current Worksheet</td>
<td>8.11</td>
</tr>
<tr>
<td>• Printing a Report from a Worksheet Query</td>
<td>8.12</td>
</tr>
<tr>
<td>• Deleting a Worksheet from a Workbook</td>
<td>8.14</td>
</tr>
<tr>
<td>• Viewing the SQL Statement for a Worksheet</td>
<td>8.15</td>
</tr>
<tr>
<td>Using the Query Governor Feature</td>
<td>8.16</td>
</tr>
</tbody>
</table>
Workbook-Related Tasks

This section covers the most common procedures you will do with any Discoverer workbooks.

Creating a New Workbook

To start a new workbook, do the following steps:

1. Use one of the following commands:
   • In the Discoverer menu bar, click on **File Æ New**.
   • In the Discoverer Toolbar, click on the **New Workbook** icon symbol (identified by the pointer at right).

   This will start up the Discoverer Workbook Wizard feature. The Discoverer Workbook Wizard – Step 1 of 10 screen will appear.

2. Use the **Workbook Wizard** to do the following minimum required steps:
   a. In the Step 1 of 10 screen, select the report template style you want the workbook to use initially. Click [Next].
   b. In the Step 2 of 10 screen, use the **Available** pull-down menu to select the VS_CEAH_GDB Business Area. Then add data items from this Business Area into your new workbook. Click [Next].
   c. In the Step 3 of 10 screen, change, if desired, the default report layout by re-arranging table columns and/or formatting table headings. Then click [Next].
   d. In the Step 4 of 10 screen, specify, if desired, any formatting for the data items that will be retrieved.

   You have now finished the minimum required setup tasks for the first worksheet in your new workbook.
3. At this point, you can either:
   - continue using the Workbook Wizard to set up the rest of this worksheet's properties step-by-step. To continue, click [Next].
   - leave the Workbook Wizard. Click [Finish].

   The query you just created will run. After it finishes, you can then click on the Edit Worksheet Screen icon (identified by the pointer at right) in the Discoverer Toolbar.

   Once this screen (opens) you can pick and choose which worksheet properties you want to work on by clicking on any of the tabbed dialog boxes (shown below), such as Format, Sort, and Percentages.
Saving a New Workbook

Before you save your first workbook, check with your data administrator. He or she may have set up Discoverer so that your office has both state-level and personal-level accounts. In such a case, your administrator may ask you to always create and save new workbooks to your personal Discoverer account only.

To save a new workbook you just created, do the following:

1. Have the new workbook open and onscreen. Now use one of the following commands:
   - In the Discoverer menu bar, click on File Æ Save.
   - In the Discoverer Toolbar, click on the Save Worksheet icon symbol (identified by the pointer at right).

2. A Save Workbook to Database popup window (at right) will appear. In the New Name field, type in the name you want to give to this workbook. Be careful to give your new workbook a unique name. Do not save it under a generic name, such as Workbook1.

(There are many other individuals who will also be using this Discoverer product on the same GDB database. If several people save their workbooks under the same name, these same workbook files will be overwritten each time.)

It is recommended that your office create a set of naming convention guidelines for its Discoverer workbooks and reports. Some suggestions appear below:

<table>
<thead>
<tr>
<th>Intended Use of Naming Convention</th>
<th>Syntax of Naming Convention</th>
<th>Examples</th>
</tr>
</thead>
</table>
| For an individual's workbooks     | Individual's name_description or date of workbook | Harris_premid_workbook1  
                                 |                 | Strathburg_year2002  
                                 |                 | Bruce_tb_farms_2001        |
| For workbooks shared by everyone in an office | Disease_rpt_office or state_description of workbook | BR_rpt_cincinnatipremid  
                                 |                 | PRV_rpt_AZ_fed_2003       |
Duplicating an Existing Workbook

When you duplicate an existing workbook, you are saving it under a different workbook name. Essentially, you are executing a "Save As" command on the workbook. Discoverer will create a new copy of the workbook with the same query and formatting properties.

Again, you should check with your data administrator. He or she may want you to create, save, and duplicate workbooks only to your personal Discoverer account rather than to an office or state account.

To save a new workbook you just created, do the following:

1. Have the original workbook open and onscreen. In the Discoverer menu bar, click on File → Save As.

2. A Save Workbook to Database popup window (at right) will appear. In the New Name field, type in the name you want to give to this workbook. Be careful to give the duplicate workbook a unique name.

   (You may want to refer back to the naming convention suggestions provided in the earlier procedure, Saving a New Workbook.)
Opening an Existing Workbook

To open an existing workbook, do the following steps:

1. Use one of the following commands:
   - In the Discoverer menu bar, click on `File → Open`.
   - In the Discoverer Toolbar, click on the `Open` icon symbol (identified by the pointer at right).

2. An Open Workbook popup window (at right) will appear.
   In this window, click on the radio button next to the Database option. Then click [Open].

3. An Open Workbook from Database popup window will then appear.
   In this window, highlight the workbook you want to open. Click [Open] again.
   The workbook you requested will appear onscreen. It will be open to the last worksheet that you were working in before you saved and closed the workbook.

   You may or may not see a message box asking if you want to execute the active worksheet’s query first or you just want to open the worksheet instead. To start modifying the worksheet immediately without running a query, click on [No].
Deleting an Existing Workbook

To delete a workbook that you no longer need or use, do the following:

1. In the Discoverer menu bar, click on the **File → Manage Workbooks → Delete** command (shown at right).

2. A **Delete Workbooks from Database** popup window (shown at right) will appear, listing all of the workbooks to which you have access.

   Highlight the workbook you wish to delete. Click on [Delete].

3. A popup window will appear, asking you to confirm this deletion request. Click [Yes].
Worksheet-Related Tasks

This section covers the most common procedures you will do with the worksheet(s) contained in a Discoverer workbook.

Adding a New Worksheet to an Existing Workbook

To add a new worksheet to a workbook you currently have open, do the following steps:

1. Use one of the following commands:
   - In the Discoverer menu bar, select the **Sheet → New Sheet** command.
   - In the Discoverer Toolbar, click on the **New Worksheet** icon symbol (identified by the pointer at right).

   The **Workbook Wizard, Step 1 of 10** screen will appear.

2. Use the **Workbook Wizard** to do the following minimum required steps for the first worksheet in your new workbook:
   - In the **Step 1 of 10** screen, select the report template style you want the worksheet to use initially. Click [Next].
   - In the **Step 2 of 10** screen, use the **Available** pull-down menu to select the VS_CEAH_GDB Business Area. Then add data items from this Business Area into your new worksheet. Click [Next].
   - In the **Step 3 of 10** screen, change, if desired, the default report layout by re-arranging table columns and/or formatting table headings. Then click [Next].
   - In the **Step 4 of 10** screen, specify, if desired, any formatting for the data items that will be retrieved.

You have now finished the minimum required setup tasks for this worksheet in your workbook.
3. At this point, you can either:
   
   • continue using the Workbook Wizard to set up the rest of this worksheet's properties step-by-step. To continue, click [Next].
   
   • exit the Workbook Wizard. Click [Finish].

   The query you just created will run. After it finishes, you can then click on the **Edit Worksheet Screen** icon (identified by the pointer at right) in the Discoverer Toolbar.

   Once this screen opens, you can pick and choose which worksheet properties you want to work on by clicking on any of the tabbed dialog boxes (shown below), such as **Format**, **Sort**, and **Percentages**.
Renaming a Worksheet

When you first open a new worksheet, Discoverer will assign a default name to it. To change this default name, do one of the following procedures.

**Method A:**
1. Make sure the worksheet you want to rename is the active one on your computer screen, by clicking once on its tab.

2. Choose one of the following In the Discoverer menu bar, select the Sheet → Rename command. A Rename Worksheet window (shown at right) will appear.

3. In the Rename Worksheet window, enter the new name you want to give the worksheet. Click [OK].
   The window disappears, and the new name for the worksheet will now appear on its tab.

**Method B:**
1. Double-click on the tab of the worksheet you want to rename. A Rename Worksheet window (shown at right) will appear.

2. In the Rename Worksheet window, enter the new name you want to give the worksheet. Click [OK].
   The new name for the worksheet will now appear on its tab.
Refresh the Current Worksheet

Refreshing a worksheet means you want to re-run the query stored on that worksheet.

Use one of the following commands:

- In the Discoverer menu bar, select the **Sheet ➔ Refresh Sheet** command.
- In the Discoverer Toolbar, click on the **Refresh** icon symbol (identified by the pointer at right).

The query will automatically repeat and then display any results in your worksheet. If the query has any stored parameters, you will be asked to re-enter the values for those parameters.
Printing a Report from a Worksheet Query

1. Have the appropriate workbook open. Make the worksheet whose query results you want to print the active worksheet by clicking once on its tab.

2. In the Discoverer menu bar, select the **File ➔ Print** command.

3. A **Print Wizard – Step 1 of 2** dialog box (shown below) will appear.

   ![Print Wizard Step 1 of 2: Select Objects](image)

   Click the radio button next to the option you want. Then click [Next].

   ```
   - Which worksheets do you want to print?
     - Current worksheet
     - All worksheets
   ```

   ```
   - What do you want to print?
     - Both Graph and Table / Crosstab
     - Table / Crosstab only
     - Graph only
   ```
4. **A Print Wizard – Step 2 of 2** dialog box (shown below) will appear.

Click the radio button next to the option you want. Then click [Finish].

5. A Windows **Print** dialog box will now appear. You can use this dialog box to specify the printer and any document properties (portrait or landscape orientation, single-sided or double-sided printing, etc.).
Deleting a Worksheet from a Workbook

You can easily delete a worksheet from a workbook containing several worksheets. You cannot delete a worksheet if it is the only one in a workbook.

1. In the Discoverer menu bar, select the Sheet ➔ Delete Sheet command.

2. A deletion confirmation popup message will appear. Click [Yes].

You can verify that the worksheet was deleted by looking at the worksheet tabs at the bottom of the workbook screen.
Viewing the SQL Statement for a Worksheet

You can view the SQL statement equivalent of any of your worksheet queries by doing the following procedure:

1. Finish writing your worksheet query and save it.

2. In the Discoverer menu bar, select the **Sheet → Show SQL** command (shown at right).

3. A separate **SQL Inspector Screen** (shown at right) will appear. It contains the SQL statement that represents your worksheet's query. Note that the statement contains many aliases and other elements that would need to be replaced before the statement can actually be run in SQL.

When you have finished viewing the statement, click [OK] to close this window and to return to the worksheet.

Or, you can click on [Copy]. The SQL statement will be highlighted and copied into a clipboard area in Discoverer. You can now do any of several things:

- To use this SQL statement in another program, go to your other program and use its [Paste] command to transfer the SQL statement into it.

- To save this SQL statement as a file, open a word-processing program or a Windows utility program such as Notepad. Use the program's [Paste] command to transfer the SQL statement into it. Then use the program's [Save As] command to save this SQL statement as a file. Be sure to attach the `sql` extension to the end of the filename.
Using the Query Governor

Sometimes a query will retrieve an astonishing amount of data – you could find your printed report exceeding hundreds of pages. To prevent this problem, Discoverer has a feature called the **Query Governor**. This feature lets you set such limits as how long a query should run or how the query should display its results in your worksheet or report printout.

To access and use the Query Governor, do the following steps:

1. **Access the **Query Governor** feature in any of the following ways:**
   - If you are working within the **Workbook Wizard**:
     1. Click on the [Options] command button below the workbook window.
     2. When the **Options** window appears, click on the Query Governor tab.
   - If you are working within the **Edit Worksheet Screen**:
     1. Click on the [Options] command button below the workbook window.
     2. When the **Options** window appears, click on the Query Governor tab.
   - If you simply have a worksheet open onscreen:
     1. Go to the Discoverer menu bar and select **Tools → Options**.
     2. When the **Options** window appears, click on the Query Governor tab.
2. The **Query Governor** tabbed page will appear onscreen.

![Options tabbed page](image)

3. At the bottom of this page, in the **Query Governor** block, there are three options that you should consider customizing for your Discoverer workbooks. (All of the other options on this page will need your database administrator's input.)

   The first option you should customize is the **Warn me if predicted query time exceeds** field. This option lets you instruct Discoverer to display a warning message if the execution time of your query exceeds the time you enter into this field.
   a. Make sure a check mark appears in the box next to this field label.
   b. In the field, click the up and down arrows to set the time limit that you want.

4. The next option you should customize is the **Prevent queries from running longer than** field. This option lets you pre-set the maximum length of time you want Discoverer to use to run a query.
   a. Make sure a check mark appears in the box next to this field.
   b. In the field, click the up and down arrows to set the time limit that you want.
5. The last option you should customize is the **Limit retrieved query data to** field. This option lets you pre-set the maximum number of rows (records) that Discoverer should retrieve for your query.
   
a. Make sure a check mark appears in the box next to this field.

b. In the field, click the up and down arrows to set the desired number of rows.

This option is probably the most useful option. By controlling the number of records that Discoverer can retrieve, you are controlling the results as they appear onscreen in your worksheet or off-screen in a printed report. Note, however, that if your query returns exactly 10,000 rows, you may not be seeing all of the records your query should return, due to this feature of the query governor. If you want to see every row returned by your query, you should increase the number here.

6. After you have customized these three options, click [OK]. The Query Governor tabbed page will close, and you will see your active worksheet again.

You can see how these modified options now affect your queries. Click on the **Refresh** icon in the Discoverer menu bar to run a new query from your active worksheet.
Chapter 9:
Using Calculations, Functions, and Table Joins in Oracle Discoverer Plus™
Chapter 9:
Using Calculations, Functions, and Table Joins in Oracle Discoverer Plus

For this release of Discoverer, you can run multi-table queries using any of the following methods:

• Pre-defined Table Joins
• Pre-defined Calculations
• Functions within Calculations

This chapter covers the following topics:

<table>
<thead>
<tr>
<th>Topic</th>
<th>See Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>1…Using Pre-Defined Table Joins</td>
<td>9.2</td>
</tr>
<tr>
<td>2…Using Pre-Defined Calculations</td>
<td>9.2</td>
</tr>
<tr>
<td>3…Incorporating Functions within Calculations</td>
<td>9.4</td>
</tr>
</tbody>
</table>
1…Pre-Defined Table Joins

These appear in the Discoverer Workbook Wizard – Step 2 of 10: Select Items Screen. You can recognize them by the ALL as their suffix.

<table>
<thead>
<tr>
<th>Name of Table Join</th>
<th>Description of the Table Join's Contents</th>
</tr>
</thead>
<tbody>
<tr>
<td>PR ALL</td>
<td>Contains all 35 data fields in the Premises Table, plus 3 lookup lists.</td>
</tr>
<tr>
<td>PS All</td>
<td>Contains all 25 data fields in the Premises_Supplemental Table, plus 3 lookup lists.</td>
</tr>
<tr>
<td>PD All</td>
<td>Contains all 15 data fields in the Premises_Supplemental_Detail Table, plus 3 data fields from other GDB Tables.</td>
</tr>
<tr>
<td>St All</td>
<td>Contains all 36 data fields in the Status Table, plus 8 lookup lists, plus 38 data fields from other GDB Tables.</td>
</tr>
<tr>
<td>ES All</td>
<td>Contains all 48 data fields in the Status Table, plus 10 lookup lists, plus 29 data fields from other GDB Tables.</td>
</tr>
<tr>
<td>SA All</td>
<td>Contains all 44 data fields from the Sample Table, plus 12 lookup lists, plus 68 data fields from other GDB Tables.</td>
</tr>
<tr>
<td>TR ALL</td>
<td>Contains all 11 data fields from the Test_Results Table, plus 3 lookup lists, plus 2 data fields from other GDB Tables.</td>
</tr>
</tbody>
</table>

2…Using Pre-Defined Calculations

These appear in the Workbook Wizard – Step 7 of 10: Calculations Screen. They are a method for returning data without having to perform joins. They return data that are provided in the ALL tables selectively. These calculations are more efficient than the ALL tables, and will not cause as much decline in performance.

All calculations defined for use with the GDB start with the prefix ‘GT’.

The syntax of a pre-defined calculation is this:

Function (input field1, input field2, etc) return field

A calculation is coded in this format:

GT_EVNTTYPE(DZ,SP,CD)

An example of a pre-defined calculation is this:

GT_EVNTTYPE(BR,BOV,INSP) = will return an EVENT TYPE DESC
Rules for Using Calculations

- Use the Discoverer Plus drop-down lists of Values to select the items for each item in a calculation. Do not type an item value.
- All fields in a calculation need to be defined.

List of Pre-Defined Calculations

<table>
<thead>
<tr>
<th>Name of Calculation</th>
<th>Returns this Data</th>
</tr>
</thead>
<tbody>
<tr>
<td>GT_AGECD(DZ,SP,CD)</td>
<td>Returns AGE DESC</td>
</tr>
<tr>
<td>GT_DISPCD(DZ,SP,CD)</td>
<td>Returns DISPOSITION DESC</td>
</tr>
<tr>
<td>GT_EVNTRSNS(DZ,SP,CD)</td>
<td>Returns EVENT REASON DESC</td>
</tr>
<tr>
<td>GT_EVNTTYPE(DZ,SP,CD)</td>
<td>Returns EVENT TYPE DESC</td>
</tr>
<tr>
<td>GT_ISSRSN(DZ,SP,CD)</td>
<td>Returns ISSUE REASON DESC</td>
</tr>
<tr>
<td>GT_PAYCD(DZ,SP,CD)</td>
<td>Returns PAYCODE DESC</td>
</tr>
<tr>
<td>GT_PRTYPE(DZ,SP,CD)</td>
<td>Returns PREM TYPE DESC</td>
</tr>
<tr>
<td>GT_RELRSN(DZ,SP,CD)</td>
<td>Returns RELEASE REASON DESC</td>
</tr>
<tr>
<td>GT_SEXCD(DZ,SP,CD)</td>
<td>Returns SEX DESC</td>
</tr>
<tr>
<td>GT_TSTCD(DZ,SP,CD)</td>
<td>Returns TEST DESC</td>
</tr>
<tr>
<td>GT_TSTINT(DZ,SP,CD)</td>
<td>Returns TEST INTERP DESC</td>
</tr>
<tr>
<td>GT_CNTY_NM(STCD,CNTYCD)</td>
<td>Returns COUNTY NAME</td>
</tr>
<tr>
<td>GT_REG_STG(STCD,CNTYCD,DZ,SP,BDT,EDT)</td>
<td>Returns STAGE</td>
</tr>
<tr>
<td>GT_ST_NM(STCD)</td>
<td>Returns STATE NAME</td>
</tr>
<tr>
<td>GT_BRE_NM(BRECD,SP)</td>
<td>Returns BREED NAME</td>
</tr>
<tr>
<td>GT_DZ_NM(DZ)</td>
<td>Returns DISEASE NAME</td>
</tr>
<tr>
<td>GT_SP_NM(SP)</td>
<td>Returns SPECIES NAME</td>
</tr>
<tr>
<td>GT_COMM_(COMMID,COMMST,INDCOMM,COMMTYPE)</td>
<td>Returns COMM_INFO  ***</td>
</tr>
</tbody>
</table>

*** COMM table codes:

- **INDCOMM**: 1 = PERSON, C = CONTACT, P = PREMISES
- **COMMTYPE**: CELLPHONE, EMAIL, FAX, HOMEPHONE, OTHER, PAGER, PHONE, WEBSITE, WORKPHONE
3...Incorporating Functions within Calculations

These appear in the Workbook Wizard – Step 7 of 10: Calculations Screen. They return the data within the column name specified in the RTN_FLD.

Rules for Using Functions

- To get more than one column, perform multiple calls to the function.
- Use the Discoverer Plus drop-down lists of Values to select the items for each item in a function.

Adding a Function to Your Worksheet/Workbook

1. In the Main Window, open your workbook/worksheet.
2. Select the Sheet > Edit Worksheet command in the Menu Bar or Toolbar.
3. On the Edit Worksheet Screen, click on the Calculations tab.
4. On the Calculations page, click on New.
5. On the New Calculation page, in the Show column, select Functions.
6. In the Show column, click on the + sign next to All Functions to expand its list.
7. In the Show column, select the GT_<function> you want to add to your query and paste it into the Calculation column. Note that some of the fields in your GT_<function> are highlighted in blue.
8. Return to the Show column and select either Available Items or Selected Items.

When you do so, the list will display any tables whose data fields can be applied to your GT_<function>. Expand each table’s list by clicking on its + sign.
9. Back in the Calculation column, highlight just one field in your GT_<function>, such as DZ or SP.
10. In the Show column, select the item that will be inserted into the highlighted field of your GT_<function>.
11. Repeat Steps 9-10 for each field of your GT_<function> that you want to modify.
12. Be sure you have given your modified calculation a unique name by filling out the **What do you want to name this calculation?** text field.

13. When finished, click on **OK**. You return to the **Edit Worksheet Screen**.

14. Check the **Active** check box next to your modified calculation to apply it to your current workbook/sheet.

<table>
<thead>
<tr>
<th>Name of Function</th>
<th>Fields Available for the RTN_FLD</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Premises Function:</strong> GT_PR(OWNER_ID,ORIGIN_ID,PREM_ID,ST,RTN_FLD)</td>
<td>PREM_ID, PREM_STATE, PREM_NAME, PREM_ADDRESS, PREM_ADDRESS2, PREM_CITY, PREM_ZIPCODE, PREM_COUNTY, PREM_PHONE, CONTACT_LNAME, CONTACT_FNAME, CONTACT_MI, CONTACT_ADDRESS, CONTACT_ADDRESS2, CONTACT_CITY, CONTACT_STATE, CONTACT_ZIPCODE, CONTACT_PHONE, USER_FIELD_1, USER_FIELD_2, USER_FIELD_3, REMARKS, FRONT_GATE_LONG, FRONT_GATE_LAT, GEO_SOURCE, TOWNSHIP, RANGE, SECTION, QTR_SECTION, GEO_DATUM, UPDATE_DATE, UPDATE_USERNAME, NATL_PREM_ID, DATA_SOURCE</td>
</tr>
<tr>
<td><strong>Person Function:</strong> GT_PRSN(PERSON_ID,PERSO_ST&lt;RTN_FLD)</td>
<td>PERSON_ID, LNAME, FName, MI, PERSON_TYPE, PERSON_CLASS, ADDRESS, ADDRESS2, CITY, STATE, ZIPCODE, COUNTY, PHONE, SECTION, OTHER_ID1, OTHER_ID2, USER_FIELD_1, USER_FIELD_2, USER_FIELD_3, REMARKS, GEO_SOURCE, GEO_LOCATOR1X, GEO_LOCATOR1Y, GEO_DATUM, UPDATE_DATE, UPDATE_USERNAME, ADDRESS_STATE, UPDATE_USERNAME, USERID</td>
</tr>
<tr>
<td><strong>Misc Info Function:</strong> GT_MI(REC_TY,INFO_TY,PR_ID,PR_ST,ES_NR,SQ_NR,DZ,SP,PR_TY,RTN_FLD)</td>
<td>REC_NR, ENTRY_STATE, INFO_TYPE, REC_TYPE, DISEASE, SPECIES, PREM_ID, PREM_STATE, PREM_TYPE, ES_NR, SEQ_NR, DATE_FIELD_1, DATE_FIELD_2, DATE_FIELD_3, DATE_FIELD_4, INFO_FIELD_1, INFO_FIELD_2, INFO_FIELD_3, INFO_FIELD_4, REMARKS, INFO_FIELD_5, INFO_FIELD_6, DATE_FIELD_5, DATE_FIELD_6, UPDATE_DATE, UPDATE_USERNAME, NUM_FIELD_1, NUM_FIELD_2, NUM_FIELD_3, NUM_FIELD_4, DATA_SOURCE</td>
</tr>
</tbody>
</table>
Different fields are required for the MISC_INFO function, depending on what table you are pulling from or which data you wish to use. Place the word NULL in the fields you are not populating. Use the following table as a guideline:

<table>
<thead>
<tr>
<th>Table</th>
<th>Prem_id</th>
<th>Prem_st</th>
<th>Prem_type</th>
<th>Species</th>
<th>* Info_type</th>
</tr>
</thead>
<tbody>
<tr>
<td>Premises Table</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Prem_Supp Table</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Prem_Supp_Detail Table</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Event_Summary Table</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Status Table</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Sample Table</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Test Result Table</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

* *Info_type* is the kind of information you wish to retrieve. This value may or may not be needed in the function you are using.
Appendix A:
Detailed Descriptions of Selectable Items in Oracle Discoverer Plus
Appendix A:
Detailed Descriptions of Selectable Items in Oracle Discoverer Plus

The purpose of this appendix is to serve as reference material for using the different screens in Oracle Discoverer Plus.

<table>
<thead>
<tr>
<th>Topic</th>
<th>See Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>1…Create Workbook screen</td>
<td>A.2</td>
</tr>
<tr>
<td>2…Table Layout – Hide Duplicate Rows</td>
<td>A.3</td>
</tr>
<tr>
<td>3…Conditions and Operators</td>
<td>A.3</td>
</tr>
<tr>
<td>4…AND versus OR</td>
<td>A.7</td>
</tr>
</tbody>
</table>
1...Create Workbook screen

This is the screen that appears when you first create a new workbook. It is also the only step in the Workbook Wizard (step 1 of 10) that does not appear when you are editing a workbook. Once you have left this screen, you will not be able to change the type of workbook you create.

- **Table** – This is the standard table layout, with rows and columns
- **Page-Detail Table** – This is a special table layout where you can designate certain items as **Page Items** in the Table Layout of your report. These **Page Items** then do not display, but become dynamic filters you can use within your worksheet. For example, if you designate the “Species” field as a Page Item, you will then be able to select different species codes to show in your report.
- **Crosstab** – A crosstab report is exactly like a pivot table in Microsoft Excel. It shows data along three dimensions, usually with summary information inside the table cells. So for example, you might see the number of status records entered, by species, disease, and status code.
- **Page-Detail Crosstab** – This is a combination of a crosstab report and a page-detail report. You will be able to select page items as in a page-detail table, and the data will be displayed in a crosstab
2…Table Layout – Hide Duplicate Rows

This option allows you to indicate whether you would like for rows that look exactly the same to appear twice in your report. The reason why rows may appear to be identical is that you may be querying information that repeats.

For example, if you are querying event summary records, you might select disease, species, and event type. Since there will probably be multiple records with the same disease, species, and event type, checking this box will prevent multiple rows from appearing with the identical information.

3… Conditions and Operators

When creating conditions for your query, there are a number of options available to you. Below is a list of these options, and a description of what each option does.

A. Equals (=)

What you enter into the Values column must exactly match what is in the record to be returned.
For example, if you enter `Disease = ‘BR’`, you will get only those records with BR entered into the Disease field.

**B. Does not equal (`<>`, `!=`)**

If a record contains exactly what you enter into the **Values** column, it will not be displayed; all other records will be displayed.

For example, if you enter `Disease <> ‘BR’`, you will get records for all other diseases (TB, PRV, JOH, etc.) but no records with BR in the Disease field. Note that the operator `!=` functions identically to the `<>` operator; both of them mean “does not equal”.

**C. Greater than (`>`)**

This is usually used with either numbers or dates, and will return all records with a larger number, or a later date, than the one entered into the **Values** column. This is not inclusive, and will not return the actual value entered. This operator will also work with alphanumeric fields, in which it will return all values alphabetically higher than the one entered.

**D. Less than (`<`)**

Just like greater than, only this returns values smaller than the number entered, dates before the one entered, and values alphanumerically lower than the one entered.

**E. Less than or equal to (`<=`)**

This is identical to less than, except that it will also return the value entered. So for example, if the value entered was 7, this will return all records with the value 7 and lower; in contrast, if using less than (`<`), 7 would not be returned.

**F. Greater than or equal to (`>=`)**

Just like greater than, only this is inclusive.

**G. LIKE**

The LIKE operator allows you to use the Oracle wildcard, the percent sign (`%`), in your values. The wildcard stands for any value at all, and can be placed anywhere in the **Value** field. So for example, if your condition states `prem_name LIKE ‘A’`, you will get a list of all records with a prem_name that starts with A. If you enter instead `prem_name LIKE ‘%A’`, you will get a list of all records that end with an A. You can put
wildcards inside terms, so `prem_name LIKE 'A%B'` will return all records with a `prem_name` that starts with A and ends with B. You can even use multiple wildcards; the condition `prem_name LIKE '%A%'` will give you a list of all records with a `prem_name` that contains the letter A. Note that the LIKE operator does not work with date fields, only numerical and alphanumeric fields. Also, note that if you use the LIKE operator but do not place a wildcard in your Value field, it will function in exactly the same way as the Equals operator (i.e., records must exactly match what you place in the Value field).

**H. IN**

The IN operator lets you make a list of items, separated by commas, which will all return records in your query. So for example, you can make a condition stating `species IN 'CER','ELK','DER','WTD'`, and this condition will return all records containing the species codes for cervidae, elk, deer, and white-tailed deer. Note that you do not need to enter the single quotes around each term – except in the rare condition that you are actually looking for a value that contains a comma; otherwise, Discoverer will automatically add the single quotes around any terms you have separated by a comma. Also note that if you only enter one term, the IN operator functions in exactly the same manner as the EQUALS (=) operator.

**I. IS NULL**

The IS NULL operator will return all records where the field in the Item column is null, i.e., has not had any values entered into it. Note that this is not the same as a field (such as `nr_neg`) having a zero in it; zero, or a space, is actual data that can be entered into a field and stored in a database. A field that is null, on the other hand, has nothing at all stored in it, not even a zero or a space. This operator is extremely useful when looking for things like open status records; if your condition states `release_rsn IS NULL`, you will get a list of all open statuses.
J. IS NOT NULL

The IS NOT NULL operator will return all records that have a value stored in the field in the Item column. This value can be anything – even a space or a zero; as long as there is some value stored in that field, then that record will be returned. For example, if you want a list of animal IDs entered into the ID1 field, you perhaps will not want to see any records that do not have anything in the ID1 field; you can then create the condition ID1 IS NOT NULL, and you will only get records that have some value stored in the ID1 field.

K. NOT IN

The NOT IN operator will return all records that do not contain the list of values you enter into the Values column. This work exactly opposite to how the IN operator works. Let’s say you’re running a query, but you don’t want to see any records that have any of the porcine species codes. Your condition would be Species NOT IN ‘POR’, ‘FER’, ‘CSW’.

L. BETWEEN

The BETWEEN operator is usually used in connection with date fields, and allows you to specify an inclusive date range. Note that when you select BETWEEN as your operator, Discoverer will provide you with two places in the Values column to enter your two terms. So for example if you want to see all event summary records entered during May 2007, you will use the condition event_entry_date BETWEEN ‘01-May-2007’ and ‘31-May-2007’. Since the BETWEEN operator is inclusive, this will also return records that were entered on May 1 and May 31.

M. NOT BETWEEN

The NOT BETWEEN operator functions just like the BETWEEN operator, except that you will see all of the records that do not have values between the values you enter. This can be useful to find data outliers; for example, if you expect to always see ten to one hundred animals tested negative, you could use the condition nr_neg NOT BETWEEN 10 and 100 to see those records with less than ten, or more than 100, negative animals.

N. NOT LIKE

The NOT LIKE operator is a bit confusing; you can enter a term with a wildcard (%) into the Values column, and Discoverer will return all records
that do not match that value. So, for example, if you enter the condition `prem_name NOT LIKE ‘A%’, you will see all records with premises names that do not start with an A.

4...AND versus OR

When creating multiple items within a single condition by using the Advanced button on the Conditions screen, you will notice that your two items are joined by a new column called Group, and this column has an AND in it.

<table>
<thead>
<tr>
<th>Group</th>
<th>Item</th>
<th>Condition</th>
<th>Values</th>
</tr>
</thead>
<tbody>
<tr>
<td>AND</td>
<td>Disease</td>
<td>=</td>
<td>‘BR’</td>
</tr>
<tr>
<td></td>
<td>Event Entry Date</td>
<td>BETWEEN</td>
<td>‘31-MAY-2007’ AND ‘31-MAY-2007’</td>
</tr>
</tbody>
</table>

What this AND means is that both of the items in your condition must be met in order for a record to appear in your query results. In the above example, only event summary records that have a disease of BR and an event_entry_date in May 2007 will appear. If a record has the disease of BR, but the event_entry_date is not in May 2007, that record will not be returned. Likewise, a record that was entered in May 2007 for pseudorabies will not be returned. Therefore, the AND operator will further limit the records you get back, since both condition terms must be met.

The AND in the Group column has a drop-down arrow next to it, which allows you to change the AND to another operator (OR, NOT AND, or NOT OR). We won’t discuss NOT AND or NOT OR as these are complex logical operators with extremely limited application.

The OR in the Group column gives you another way to link the different items in your condition. Using OR will return records that meet either of the items in the condition. Using the above example, all event summary records with a disease of BR would be returned (regardless of event_entry_date), and all records entered during May 2007 would be returned, regardless of the disease. Therefore, the OR operator will expand the records you get back, since a record only has to meet one of the condition terms in order to be returned. Notice that if you put the same field in the Item column several times and join it with an OR, such as stating `Disease = ‘TB’ OR Disease = ‘BR’ OR Disease = ‘PRV’, this is identical to us

As you can see from the below example, you can make your condition statement very complex.
In this example, most of the items in the **Values** column are parameters, which allow the user to re-run the report using different values for those condition terms. The way this condition would read is: The disease must match what the user enters, or the user can enter “ALL”; there are three different species that the user can select, and records containing any of those species will be returned (due to the OR linking them); the event_entry_date must be between the two values the user enters; the prem_type must be “MKT”; the event_rsn must be either “MK” or “MCI”; and the event_type must be “TEST” (due to the AND linking all of these items).